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Yes, folks, it’s that time of year again—included in this very issue you now hold in your hands is my 9th annual “Gonzo Holiday Gear 

Guide” filled with all the same “gonzoness” as last year, but with awesome new stuff. I’ve included everything from inexpensive 

stocking stuffers to the perfect gift for the rich doctor or investment banker on your holiday list. The guide starts on page 56 in 

case you want to get right to the goodies. 

In other news, we’re always looking for ways to connect with our members and keep you on top of what’s going on in the  

Photoshop universe, so we just launched a brand-new daily blog from The Photoshop Guys (RC Concepcion, Matt Kloskowski, 

Corey Barker, Pete Collins, and me) along with some special guests who’ll be contributing, as well. We’ll post fresh Photoshop, 

Lightroom, and photography stuff daily, so I hope you’ll come by and join us in this part of our community. We even made the 

URL pretty easy: kelbyone.com/blog.

Back here in the mag, we have a lot more to cover besides the Gear Guide. We receive lots of questions about hardware for 

running Photoshop at its best, so our own RC Concepcion talks about what he takes into consideration when buying computers, 

RAM, hard drives, and displays to make sure Photoshop runs, and looks, like a dream (p. 66). He’s the perfect guy for this because 

he’s a total gear head, and he’s always trying to get the most out of his rig. 

For our Web designers out there, Janine Warner talks about new features in the Web design apps that were recently on display 

at the Adobe MAX conference, including the new Extract Assets feature in Photoshop (p. 50). In our “Dynamic Range” column 

(p. 94), Kevin Ames shows us how to take full advantage of our RAW data in Camera Raw not only when it comes to exposure 

and color, but creativity, as well. In our Lightroom section, Rob Sylvan takes us through the JPEG export options in each module 

of Lightroom, and shows us how to get the best image quality at the smallest file size (p. 80).

Since it is that time of the year, our own Pete Collins did a piece called “Happy Holiday Photos” where he shows us how to 

practice taking great holiday photos, along with some awesome camera and lighting tips for making your family look their best 

(p. 74). If you’re a more advanced user, check out our article on “Channel Selections” (p. 100) by Scott Valentine as he takes an 

in-depth look at selecting luminosity and brightness using channels. These selections can be used to make highly fine-tuned masks 

for correcting images.

There’s lots of cool stuff in this issue, but don’t forget—the learning doesn’t stop here in the magazine, or with our online 

classes (did you know we release at least one class every Thursday and sometimes even more?), now that we’ve added another 

leg to all of our training options with the new kelbyone.com blog, so we have you covered.

Happy Holidays to everyone from the team here at KelbyOne. 

 All my best,

Scott Kelby

KelbyOne President & CEO

Editor & Publisher, Photoshop User

From the Editor
 going gonzo over the holidays
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MICHAEL CORSENTINO 
is an award-winning wedding and portrait photographer, Photoshop and Lightroom 

expert, author, columnist for Shutter Magazine and Resource Magazine, and speaker and 
international workshop leader. Learn more at www.michaelcorsentino.com. 

SEÁN DUGGAN 
is the co-author of Photoshop Masking & Compositing, Real World Digital 

Photography, and The Creative Digital Darkroom. He leads workshops on digital 
photography, Photoshop, and Lightroom (SeanDuggan.com).

DANIEL EAST 
is an author, free lance writer, presenter/trainer, and consultant with more than 20 years’ 

experience in photography, pro-audio, and marketing. Daniel is also founder and president 
of The Apple Groups Team support network for user groups.

SEAN McCORMACK 
is the author of Essential Development: 20 Great Techniques for Lightroom 5.  

Based in Galway, Ireland, he shoots subjects from musicians, models, and actors  
to landscapes and architecture. Learn more at http://lightroom-blog.com. 

SCOTT ONSTOTT 
is the creator of Photoshop for Architects: CC Edition and author of Enhancing Arch itectural 
Drawings and Models with Photoshop, Taking Measure (secretsin plainsight.
com), and other books and videos. See what he’s up to at ScottOnstott.com. 

COLIN SMITH 
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Photoshop User 
Magazine
Photoshop User magazine is the official publication of 
KelbyOne. It is for members and is not available to the 
public by subscription.

As a KelbyOne member, you automatically receive  
Photoshop User delivered right to your door (or digi-
tally) ten times a year. Each issue features in-depth 
Photoshop, Lightroom, and photography tutorials writ-
ten by the most talented designers, photographers, and 
leading authors in the industry.

KELBYONE 
is the world’s leading resource for Adobe® Photoshop®, Lightroom®, and 

photography training, news, and education. Founded in 1998 as the National 
Association of Photoshop Professionals (NAPP), KelbyOne has evolved from 

NAPP and KelbyTraining to create a singular hub for creative people to learn, grow, 
and inspire. From photographers to graphic designers, beginners to professionals, 

KelbyOne is open to everyone.    

There’s no faster, easier, and more affordable way to get really good at Photoshop 
and photography. You can join for only $25 per month or $249 U.S. for a full year 

of training. To learn more, visit www.kelbyone.com.

 

 

PHOTOSHOP USER MAGAZINE 
Ten issues of the best Photoshop tutorial-based magazine in the industry.  

MEMBERS-ONLY WEBSITE 
Our extensive website features time- and money-saving content.

ONLINE CLASSES & EDUCATION 
Thousands of Photoshop and photography tutorials, full online classes,  

and quick-tip videos. 

MEMBER DISCOUNTS 
Save anywhere from 2–4 times your membership cost by using our many 
industry-related discounts.

TECH SUPPORT 
Fast, friendly Photoshop, Lightroom, and photo gear help; equipment 
advice; and more from certified experts.

MEMBER COMMUNITY 
KelbyOne members range from beginners to pros and love to lend each 
other a hand. Together, we have built the friendliest, most knowledgeable 
Photoshop and photography community on the Web.

NEWS & REVIEWS 
Unbiased coverage on the latest equipment, plug-ins, and programs 
in the marketplace.

WEEKLY E-NEWSLETTER 
The KelbyOne Insider is your weekly connection to everything KelbyOne.  
It’s produced exclusively for members to keep you informed of everything 
new in the industry and at KelbyOne headquarters.

REGISTRATION DISCOUNT 
TO PHOTOSHOP WORLD 
CONFERENCE & EXPO 
The annual KelbyOne convention and the largest Photoshop and  
photography learning experience on the planet. It’s an amazing event.

FIND KELBYONE MEMBERSHIP DETAILS AT kelbyone.com or call 800-738-8513 Monday–Friday, 9:00 a.m. to 5:30 p.m. EST.

About KelbyOne

Member Benefits
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An Amazing Day  
around the world 
I’m pretty sure if we could solve world peace with photography, we 

would have done just that on October 11, 2014. More than 20,000 

photographers in countries all over the world took to the streets to 

participate in Scott Kelby’s 7th Annual Worldwide Photo Walk. Even 

after our seventh year, the outpouring of camaraderie and creativity 

still continues to amaze us. With more than 1,000 walks worldwide, 

we saw group photos all the way from Cairo, Egypt, to San Diego, Cali-

fornia, and everywhere in between. The excitement and pure elation 

from walkers across the globe proved our goal of sharing, inspiring, and 

igniting creativity was met. (For proof, all the “Artist Spotlight” images 

on the next two pages were taken by photo walkers.)

While we didn’t solve world peace, we certainly made an impact 

on a small part of the world with our Walking with a Purpose initia-

tive. We’re astounded by the amount of donations that rolled in for 

the Springs of Hope Kenya orphanage. With more than $34,000 in 

donations, we raised more dollars than we had walkers and tripled our 

efforts from years past. Plus, with the added $2,500 from our World-

wide Photo Walk T-shirt sales, we achieved exactly what we intended 

to do and then some. Thanks to all of our photo walkers, there are 

some very happy children that are getting the help they so dearly need 

and deserve.

It’s hard to believe such a remarkable event has come and gone, but 

the memories and friends made will definitely last a lifetime. You can 

learn more and count down the days to the next Photo Walk at Kel-

byone.com/photowalk. 

We’re on 
pinterest

Did you know that Pinterest.com is one of the newest (and most addicting—don’t 

say we didn’t warn you!) social spots to discover and share interests? Because we 

like to stay on the forefront of all things cool, creative, and fun, we have our very 

own KelbyOne Pinterest page up and running.

On our Pinterest boards, you can explore everything from pinned articles, tips, 

and tutorials to inspiring images and behind-the-scenes photos from KelbyOne. 

Plus, it’s the perfect avenue not only for our fans to share images, but also to 

participate in awesome contests where you can win free Kelby swag. If you haven’t followed us already, be sure to check it out at 

Pinterest.com/KelbyOne.

ARTIST SPOTLIGHT ›  ›  MIKE BEECHAM (LONDON WALK) 

MEMBER SINCE 2013 | TWITTER.COM/MIKEBEECHAM

ARTIST SPOTLIGHT ›  ›  PAULO SOUZA (BRAZIL WALK) 

WWW.PAULOSPHOTOGRAPHY.COM

ARTIST SPOTLIGHT ›  ›  MARY KELLER (ORLANDO WALK) 

MEMBER SINCE 2014 | WWW.FLICKR.COM/PHOTOS/64857768@
N03

Photoshop User 
magazine, live! 
Did you know the pages of Photoshop User magazine come to life each week in a little show we like to call Photoshop User TV? 

Every Thursday, you can catch a new episode airing over at kelbytv.com, plus view past episodes you may have missed. Watch, 

learn, and of course, laugh along with Photoshop Guys, Pete Collins and Corey Barker, as they deliver the latest techniques in 

Photoshop. Every episode is packed with easy-to-follow tutorials that you can apply and put to use in your next project. Be sure 

to tune in and catch up on new tools and tricks you can add to your creative toolbox.

ARTIST SPOTLIGHT ›  ›  NAOUFAL SELMANI  
(LONDON WALK) 

WWW,FACEBOOK.COM/IANDTHECAMERA.D52

www.KELBYONE.com
Kelbyone.com/photowalk
Kelbyone.com/photowalk
Pinterest.com
Pinterest.com/KelbyOne
twitter.com/mikebeecham
WWW.paulosphotography.COM
www.flickr.com/photos
kelbytv.com
facebook.com/iandthecamera


ARTIST SPOTLIGHT ›  ›  ERIKA THORNES (SAN DIEGO WALK) 

MEMBER SINCE 2010 | WWW.ERIKATHORNES.COM

ARTIST SPOTLIGHT ›  ›  BRIAN JOHNSON (LONDON WALK) 

WWW.NUTTYPICS.CO.UK

Fresh New Classes
released at kelbyone.com  
Here’s a roundup of our latest classes and tutorials that 

you won’t want to miss. Log into your member account at  

KelbyOne.com or check out these new releases on our app. 

Not a member? You can try KelbyOne for free. Visit KelbyOne 

.com/freetrial to view these classes and more. 

Cloning and Healing Crash Course

The cloning and healing tools in Photoshop are incredibly pow-

erful and indispensable for retouching images, but sometimes 

it can be hard to figure out exactly how these tools work their 

magic. Pete Collins covers the power that Photoshop cloning 

tools have. 

Trailblazers: Powerful Women of Photography  

the Erika Larsen Interview

Erika Larsen is a contributor to National Geographic magazine 

and her work has been exhibited at the Smithsonian National 

Portrait Gallery in Washington, D.C. Mia McCormick sat down 

with Erika for an in-depth interview about her life and passion 

for photography and the lengths she goes to “embed” with 

her subjects.

Making the Switch from Aperture to Lightroom

Matt Kloskowski takes you step by step through the migration 

process from Aperture to Lightroom, and then introduces you 

to the most important features and functions in Lightroom 

that you’ll need to know to get started with a new workflow.

How to Shoot Tack Sharp Images

Join Matt Kloskowski as he walks you through all of the fac-

tors you need to consider to nail tack-sharp photos every 

time. Once you have the shot, Matt shows you how to make 

those sharply focused photos appear even sharper through a 

number of Lightroom and Photoshop techniques.

Www.erikathornes.com
WWW.nuttypics.co.uk
kelbyone.com
KelbyOne.com
https://keepsnap.com
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Who's Who 
 in the kelbyone community

 In the October issue of Photoshop User, we challenged your 

creative chops by asking you to “Show Us Your Tricks” in 

a Halloween-inspired Community contest. The entries were 

ghoulish, spooky, and some, well, downright scary. Out 

of all of them, our very own effects master, Corey Barker, 

chose one lucky winner to be featured here. We present to 

you Sandy Fite and his energetic and ever-so-creative Yearly 

Maintenance. Read on about how self-taught graphic artist 

Sandy keeps his creative engine running.

What was your inspiration behind Yearly Maintenance? 

I wanted to avoid the typical pumpkins and such, so my idea 

was that the creatures had to hit the garage and get some 

work done before the big night.

You mentioned you were self-taught. How has KelbyOne 

helped in that process?

It wasn’t until I joined in 2012 that I got real tutorials from 

Corey and Pete. Before then I just watched every YouTube 

video I could get my hands on. When I was offered a full-time 

position as a graphic artist, I had just three months to get 

ready. KelbyOne definitely helped me get there. 

What’s one of the most helpful tips or lessons  

you’ve received?  

It’s hard to pin down, but I was on Photoshop 7 until 2012, so 

learning the CS platforms and updates was all I focused on. 

Everything I could soak up, I did. I would have to say overall 

it was learning adjustment layers. There are some pieces I do 

that have upward of 40 or 50 of them—great stuff! 

In the spirit of the contest, what’s your survival strategy 

for a zombie attack? 

Zombies—I am not sure I would want to live in that world, 

so I probably would be the guy to attack head-on and go 

down in a blaze of glory. People love heroes! 

Any other proud moments in your career as an artist 

you’d like to brag about?  

This one is pretty great. It means more when peers acknowl-

edge you compared to clients. Getting to work on Marvel 

comic characters for Marvel Universe Live has been pretty cool 

lately, as well. I would love to work on movie posters, and see-

ing one go international would be a dream come true. 

If you could pick your life’s theme song, what would 

you choose?  

I don’t really have one, but I imagine an electronic-based rock 

opera by Rob Zombie would do just fine. 

Rock on, Sandy! Keep that creative fire lit, and we’ll be sure 

to stand behind you when zombies attack. Check out more of 

Sandy’s work at sandyfiteprivate.wix.com/sandyfitegraphics.Sandy Fite

Spread the
good word

Teaching is our passion. It’s in everything we do. And hearing 

your success validates the very reason why we’re here. So preach 

on about the good word. We’re all ears. 

“Had a load of fun on my first Scott Kelby Worldwide Photo 

Walk. Great idea and great work by Scott, his gang, and all the 

group leaders.”—Jason M.

“#WWPW2014 From the Athens GA (USA) WWPW, inside 

of The University of Georgia’s historic Sanford Stadium. It was 

heavy overcast early in the day, and the difference between 

the rolling skies and the red bleacher seats made a nice con-

trast.”—Christopher B.

“The best thing I did for my photography is to treat myself to 

Photoshop World. This past September was the first time that 

I attended. I finally feel like my photos are moving to the next 

level. If anyone is wondering if it is worth it, it is! Can’t wait for 

next year.”—Debbi M. ■

sandyfiteprivate.wix.com/sandyfitegraphics
http://www.tamron-usa.com
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BY MIKE MACKENZIE AND CHRIS MAIN

 ›  ›  e x p o s e d :  i n d u st r y  n e w s

Extensis Releases  
 suitcase fusion 6

In late October, Extensis announced the immediate availability of Suitcase Fusion 6, a professional font manager that allows design-

ers to organize their font collections into a single, searchable location. Suitcase Fusion 6 is capable of handling large font collections 

and provides designers with the tools to address problems associated with large collections, namely finding, sorting, and using them. 

Fonts are organized into a single, secure, searchable location where they’re automatically checked for corruption and duplicates are 

excluded. Designers can quickly access thousands of free Google fonts without leaving the application, as well as organize fonts in 

any way they see fit, enter custom text to view fonts, compare fonts side by side, and more. The Fontspiration panel provides design-

ers with creative inspiration by showing art, typographical specimens, and more without cluttering the workspace. 

Suitcase Fusion 6 is optimized for design workflows with Adobe Creative Cloud 2014 applications and provides high-resolution 

font previews. It autoactivates fonts using plug-ins and panels for applications including Adobe Photoshop, Adobe InDesign, and 

Adobe Illustrator. Users can sync fonts on home and work computers using their Dropbox or Google Drive accounts, making it easy 

to transfer collections with cloud-based archives and restore.

Suitcase Fusion 6 is compatible with Mac OS X Yosemite and Windows 8. It’s available now from Extensis for $119.95 for a new 

license, or $59.95 to upgrade from previous versions. For more information, visit www.extensis.com.

DxO OpticsPro 10 
 adds clearview and improved denoising
As we were going to press, DxO Labs announced the immediate availability of DxO OpticsPro 10 

image processing software. It’s available in Essential and Elite Editions, as well as part of 

a Photo Suite. New to version 10 Elite is ClearView, a feature that eliminates atmospheric 

haze and smog in photos. It analyzes the color components of each pixel and improves the 

contrast locally in one click. Experienced photographers may choose to modify the intensity 

of the effect and tailor the corrections to individual taste.

Improved for version 10 Elite is DxO’s PRIME denoising technology that, according to DxO, 

now reveals more details with processing up to four times faster. The Noise Reduction palette 

has a larger area for previewing denoising. PRIME denoising technology analyzes the fine struc-

ture of an image to differentiate between noise and fine details. When analyzing individual pix-

els, surrounding pixels are also studied to identify similarities and combine information, yielding 

better textures, details, and color saturation.  

DxO Smart Lighting, included in both Essential and Elite Editions, is a feature that optimizes 

the contrast of an entire image and now offers better rendering in version 10. It can be used 

in automatic mode for simple operation, or in manual mode to access Selective tone sliders for 

more control.

DxO OpticsPro Essential Edition is available for $129, and the Elite Edition with ClearView and PRIME denoising is available for 

$199. DxO Essential Photo Suite comes with DxO FilmPack 5 Essential Edition and DxO ViewPoint 2 and costs $189. Finally, DxO 

Elite Photo Suite includes DxO FilmPack 5 Elite Edition and DxO ViewPoint 2 and goes for $289. For more information about the 

Essential and Elite Editions, plus the FilmPack 5 and ViewPoint 2 plug-ins, visit www.dxo.com. 

Exp  sed: Industry News
The latest news about photography gear, software, and services›  ›

Epson Announces 
surecolor p600 inkjet printer
The day before PhotoPlus Expo in New York, Epson announced the SureColor P600 13" professional 

inkjet printer. The P600 combines an advanced MicroPiezo AMC printhead with next- 

generation Epson UltraChrome HD pigment inks to produce exhibition-quality black-and-white 

and color prints. Front-in and front-out paper paths enable borderless printing up to 

13x19" on glossy, matte, and fine art papers. Improved roll paper support allows 

photographers to print panoramas more than 10' long.

The P600 uses an eight-color UltraChrome HD ink set and a MicroPiezo print head 

that produces a maximum resolution of 5670x1440 optimized dpi and variable-size 

droplets down to two picoliters. Three-level black ink technology uses black, light black, 

and light light black inks for richer blacks and superior gray balance. It automatically switches 

between photo and matte black inks to produce the deepest blacks and richest colors, and Save Ink 

Mode uses less ink when switching. There’s an advanced black-and-white photo mode that offers four presets—neutral, 

warm, cool, and sepia—for neutral or toned black-and-white prints.

The P600 has a 3.5" tilting color LCD and touch panel for easy operation. For added convenience, users may connect via USB, 

Wireless n, Wi-Fi Direct, or wired Ethernet.

The Epson SureColor P600 will be available in the first quarter of 2015 for $799. For more details, visit www.epson.com. ■

HDR Express 3 
now available
Unified Color Technologies announced the immediate availability of HDR Express 3, a standalone application or Lightroom plug-in 

that enables users to create natural-looking HDR images. According to Unified Color, HDR Express features professional HDR technol-

ogy with a simple interface to produce the best possible image.

New features include a visual file browser with automatic grouping of exposure brackets, as well as new merge, alignment, and 

deghosting algorithms. Adaptive tone mapping algorithms are improved to match processing to each image, and the new Gamma 

Control slider allows users to fine-tune midtone brightness. RAW file support has been expanded to include more than 600 cameras.

HDR Express 3 is available now for $79. For more information, visit http://unifiedcolor.com. 

Announcements from 
adobe max
In an attempt to create a more connected mobile and desktop workflow, many of the announce-

ments at Adobe MAX centered around nine new and updated mobile apps. First up is the 

Photoshop family of mobile apps. Photoshop Sketch includes new built-in expressive brushes; 

Photoshop Mix has been updated to extend precise mobile compositing, and now comes in an 

iPhone version; and the Lightroom Mobile app allows others to select favorites and leave com-

ments on shared photos, and GPS information from iPhone photos now syncs with the desktop 

version of Lightroom.

In the Illustrator family of mobile apps, Illustrator Draw (formerly Adobe Ideas) offers vector 

drawing tools in a streamlined interface. Illustrator Line gives users new features for distributing 

shapes as they draw, as well as access to these vector paths in Illustrator CC.

Adobe also introduced a new category of “capture” mobile apps. With Adobe Brush CC, 

users can create custom brushes from photographs, which can be used in CC desktop apps. 

Adobe Shape CC converts anything the camera can see into vector art, which can be shared 

with Illustrator CC and Adobe Illustrator Line. Adobe Color CC (formerly Adobe Kuler) allows 

users to capture colors to use with CC apps.

Also new are Creative Cloud Libraries, which allow your colors, text styles, brushes, graphics, 

etc. to travel with you, as they are available in all your Adobe desktop and mobile apps. These 

assets will be connected through your new Creative Profile. Adobe also introduced Creative 

Cloud Market, a collection of content accessible to Creative Cloud members. This content 

includes thousands of files such as user interfaces, patterns, icons, brushes, and vector shapes. 

The new Creative Talent Search service connects creatives with job opportunities all around the 

world. Custom algorithms recommend qualified candidates and the system gets smarter the 

more a recruiter uses it.

Finally, Adobe announced new features in all of their CC desktop apps. New features in Photoshop include the Creative 

Cloud Libraries, Extract Assets (see “By Design,” page 50), improved guides, new 3D print features, touch support on Windows 

8.1 and on the Surface Pro, and Mercury Graphics Engine performance boost. Illustrator includes a new Curvature tool, touch 

workspace, Join tool, and area-type auto-sizing. For more on all the new features in the CC desktop apps and mobile apps, visit 

www.adobe.com. 

www.extensis.com
www.dxo.com
www.epson.com
http://unifiedcolor.com
www.adobe.com
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With another year of Photoshop World done, I’m excited to share 
some of the stuff I came up with for this year’s theme, which was 
Pirates of the Caribbean. We filmed the keynote movie on a pirate 
ship in Tampa Bay with a great Jack Sparrow impersonator. I man-
aged to take a few candid shots of our actor during the filming. 
Here, we’ll generate a cool movie poster effect with this snapshot. 

creating a pirate-themed movie poster 
B Y  C O R E Y  B A R K E R

Step One: Start by opening the pirate shot that’s part of the 

download files available for KelbyOne members. Though it’s a 

candid shot, I really like how he’s positioned along with his bound 

hands. This makes it a great candidate for a cool pirate composite.

[KelbyOne members may download the files used in this tuto-

rial at http://kelbyone.com/magazine/issue/december-2014. 

All files are for personal use only.]

Step Two: Create a new document measuring 13.5x20"at  

150 ppi in which to build the design. Using the Move tool (V), 

drag-and-drop the pirate photo over to this new document. Press 

Command-T (PC: Ctrl-T) for Free Transform so you can scale and 

position the image to best fit the composition. Hold the Shift key 

to maintain proportions. You can see we’re using nearly the entire 

image but scaled slightly larger than the new document and off-

set to the right a bit. Press Enter to commit the transformation.

Step Three: Now open the back-

ground texture file that’s also part 

of the exercise downloads. This 

will be used for the overall back-

ground texture but we’re going 

to do it a little differently. Once 

you have the file open, bring it 

over to the main document and 

scale it to fit in the overall compo-

sition. Then, position the texture 

layer (Layer 2) below the pirate 

layer (Layer 1) in the Layers panel.

Step Four: Make a dupli-

cate of the texture layer 

by pressing Command-J 

(PC: Ctrl-J). Turn off both 

the duplicate layer and 

the pirate layer for the 

moment by clicking their 

Eye icons in the Layers 

panel, and activate the 

original texture layer. Go 

to Filter>Blur>Average. 

This will fill the layer with 

the dominant color in the 

texture, thus creating a 

base color layer. 
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Step Two

Step Three

Step Four
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Step Five: Activate the duplicate tex-

ture layer (Layer 2 copy) and make it 

visible by clicking where its Eye icon 

used to be. Drop the layer Opacity 

to 50% and then press Command-L 

(PC: Ctrl-L) to open Levels. Grab the 

middle gray midtone slider under the 

histogram and push it to the left a bit 

to slightly lighten the texture. Click OK 

when done.

Step Six: Activate the pirate subject 

layer and make it visible. Notice that 

up close the image is rather blurred. 

Since we’re going to stylize this image, here’s a cool trick to help 

sharpen it. Go to Filter>Texture>Grain. Set the Grain Type to 

Speckle, then set the Intensity to 30 and the Contrast to 1. This 

will add a stylized grain to the image and slightly sharpen it as a 

byproduct. Click OK when done. (Note: If you don’t see Texture 

in the Filter menu, go to Photoshop [PC: Edit]>Preferences>Plug-

Ins and turn on Show All Filter Gallery Groups and Names.)

Step Seven: Make a duplicate of this document by going to 

Image>Duplicate and clicking OK. Go to Layer>Flatten Image to 

flatten the duplicate image, as this next step will not work on a 

layered document. 

Step Eight: Go to Image>Adjustments>HDR Toning. The set-

tings will vary for different images but start by dropping the 

Saturation to –100 to remove all color. Jump up to Detail and 

boost that a little. Drop the Exposure if the Detail setting blows 

out any highlights. Then, in the Edge Glow section, check on 

Smooth Edges, and use the Radius and Strength sliders to 

achieve the grunge effect you want. The settings here work 

well for this image. Click OK when done.

Step Nine: Once the image is processed with HDR Toning, use 

the Move tool to drag-and-drop it into the original document. 

Hold down the Shift key as you drag-and-drop so it will land 

centered and aligned with the original. If you copy-and-paste the 

duplicate image, it will be centered automatically. 

Step Ten: With the HDR Toning layer (Layer 3) still active, press 

Command-U (PC: Ctrl-U) to open the Hue/Saturation dialog. 

Check on Colorize and set Hue to around 29, Saturation to 35, 

and Lightness to around –13. Click OK. This will apply a warm 

cast over the image. Change the layer blend mode to Multiply 

and drop the layer Opacity to 75%.

Step Eleven: Activate the original pirate image layer (Layer 1), 

drop the Opacity to about 90%, and change the layer blend 

mode to Multiply. Then, go to the bottom of the Layers panel 

and click the Add Layer Mask icon (circle in a square). Select the 

Gradient tool (G) in the Toolbox. In the Options Bar, select the 

Radial Gradient icon, click on the gradient thumbnail to open the 

Gradient Editor, and choose the Foreground to Transparent pre-

set. Click OK to close the Gradient Editor. This preset will allow 

for multiple gradients on a single layer mask. Press D then X to 

set black as the Foreground color, then draw a few random gra-

dients around the edge of the layer.

Step Twelve: Do the same thing with the color base layer 

(Layer 2) that we created from the texture. Masking this layer less-

ens the intensity of the color on the overall image. 

Step Thirteen: Now let’s enhance the headpiece. Click the Cre-

ate a New Layer icon to create a new blank layer (Layer 4), drag it 

to the top of the layer stack in the Layers panel, and set the layer 

blend mode to Multiply. Select the Brush tool (B) in the Toolbox 

and choose a round, soft-edged brush. I’m also going to use the 

pressure sensitivity of my Wacom tablet here by setting the Opac-

ity Jitter in the Transfer section of the Brush panel (Window>Brush) 

to Pen Pressure. If you don’t have a pressure-sensitive pen, then 

drop the brush Opacity down a little in the Options Bar. Click on 

the Foreground color swatch, choose a dark-red color, and click 

OK. Start painting in the red bandana. By introducing color in this 

way, it not only restores color but it also brings back detail in that 

area. You can also drop the layer Opacity to lessen the effect. We 

dropped it to 75%.

Step Fourteen: Let’s enhance color 

in other areas, like the blue in his vest. 

Start by creating a new blank layer 

(Layer 5) below the red bandana layer 

(Layer 4) and changing the layer blend 

mode to Overlay. Choose a blue color 

that’s close to the blue of the original, 

then paint the blue areas with the same 

brush as before. We dropped the layer 

Opacity down to 75%, as well. 

Step Fifteen: Add another blank layer (Layer 6) and set its 

blend mode to Overlay, as well. This time we’re going to paint 

with white in areas that we want to brighten and enhance, like 

around the buckle on his chest, some areas of the face and ban-

dana, and even areas around the gun and hands. 

Step Six

Step Five

Step Eight

Step Ten

Step Eleven

Step Thirteen

Step Fifteen

Step Fourteen

Step Twelve
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Step Sixteen: Here we have 

another texture file that’s part of 

the exercise downloads. This is a 

rather cool map texture that will 

play right into the overall theme 

nicely. Open the texture and drag 

it over to the main file (Layer 7). 

Use Edit>Free Transform to fill the 

image with any part of the map. 

Position the layer at the top of 

the layer stack, change the layer 

blend mode to Multiply, and drop 

the layer Opacity to 50%. Add a 

layer mask to this layer and, as we 

did before, draw radial gradients 

around the layer mask to hide the texture in critical parts like 

around the face and other detailed areas. 

Step Seventeen: To slightly offset the overall warm nature of 

the image, we’re going to use an adjustment layer. Click on the 

Create New Adjustment Layer icon (half-white, half-black circle) 

at the bottom of the Layers panel, and choose Gradient Map. 

In the Properties panel, click on the gradient preview to open 

the Gradient Editor. Click on the small gear icon at the top right 

of the dialog, load the preset group called Photographic Ton-

ing, and click Append in the resulting dialog. Within that group, 

locate the one called Cobalt – Iron 1, and select it. Click OK to 

close the Gradient Editor. Change the layer blend mode to Soft 

Light and then drop the layer Opacity to 25%.

From this point you can tweak any of the layers to whatever you 

like, but now you have a better understanding of how to blend 

layers in different ways to achieve a certain look. Try it again with 

a different image to see what you get. ■ 
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Step Sixteen

Step Seventeen

http://macphun.com/kelby
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In part one (Photoshop User, November 2014), we showed you how 
to create the semimetallic, beveled-edge base we used for the num-
ber 1 of our steampunk-style type effect. In part two, we’ll show you 
how to add gears, gauges, brackets, and bolts to give the numeric 
character a pseudomechanical, steampunk look. Now, if I could only 
mix in horror or science fiction genres into my “Down & Dirty Tricks,” 
I could cross those off the bucket list, too.

steampunk-style type effect, part two
B Y  F E L I X  N E L S O N

©
M

ig
ue

l G
ar

ci
a 

S
aa

ve
d/

D
ol

la
r 

P
ho

to
 C

lu
b

We added a 
background 
so the effects 
are viewed 
as intended 
in the final 
image. 

Shown with layer Opacity 
reduced so path is visible
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If you’re following along  

from part one, you should  

have a document with three  

layers that form the base  

of our number 1, as shown.

 [KelbyOne members 

may download the images 

we used in this tutorial 

at http://kelbyone.com/

magazine/issue/decem-

ber-2014. All images are for personal 

use only.]

Step One: Open an image of gears (watch gears work well 

because of their complexity). With the Move tool (V), click-and-

drag the gear image into the steampunk document (Layer 4) 

that we created in part one. Press Command-T (PC: Ctrl-T) 

to bring up the Free Transform bounding box. While holding 

down the Shift key (to constrain the bounding box), click-and-

drag one of the corner adjustment points toward the center 

to resize it proportionately. When you have the gear image 

about the same width as the number 1, press Enter to apply 

the transformation. You may need to reposition the gears over 

the lower portion of the number 1 (see example).

Step Two: Choose the Rounded Rectangle tool (nested under 

the Rectangle tool [U]) from the Toolbox. In the Options Bar, 

choose Path as the Tool Mode, enter 10 pixels for the Radius, 

and press Enter. Now, click-and-drag to create 

a path over the lower portion of the number 

1. This will add a Work Path to the Paths panel 

(Window>Paths). Don’t make your path too 

close to the edge (see example), as we’ll need 

the space to add brackets and bolts later on.

Step Three: With the Work Path selected in the Paths panel, 

click the Load Path as a Selection icon (dotted circle) at the bot-

tom of the Paths panel. Now click the Add a Layer mask icon 

(circle in a square) at the bottom of the Layers panel. Click the 

Add a Layer Style icon (ƒx) and choose Bevel & Emboss from 

the list. Choose Outer Bevel for Style, 100% for Depth, and  

1 px for Size. Set the Direction to Down, and change the High-

light Mode to Overlay. Don’t click OK to apply the style just yet.

http://kelbyone.com/magazine/issue/december-2014
http://kelbyone.com/magazine/issue/december-2014
http://kelbyone.com/magazine/issue/december-2014
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Add other objects, such  
as metal plates, lights, 
and rivets to achieve a 
more mechanical look.
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Step Four: Choose Inner Glow  

from the Styles list on the left 

side of the Layer Style dia-

log. Choose Multiply as the 

Blend Mode. Click on the color 

swatch, choose black as the 

color, and click OK. Enter 13 px  

for Size. Choose Gradient Over-

lay from the Styles list. Set the 

Blend Mode to Multiply and 

lower the Opacity to 60%. 

Check the Reverse box, choose 

Reflected as the Style, and 0°  

for Angle. Enter 46% for Scale 

and click OK to apply the  

layer styles.

Step Five: Open an image of a metal 

brace or bracket. Using the selection 

tool of your choice, make a selection 

of a single bracket (the bottom one 

in our example). With the Move tool, 

click-and-drag the selection into the 

steampunk document (Layer 5). Press 

Command-T (PC: Ctrl-T) to bring up the Free Transform bound-

ing box. Resize and reposition the bracket over the upper-left 

portion of the opening of the number 1. Press Enter to apply 

the transformation.

Step Six: With Layer 5 as the  

active layer, click the Add a Layer  

Style icon and choose Bevel & 

Emboss. Enter 1 px for Size, 

change the Angle to 158°, and  

lower the Shadow Mode Opac-

ity to 50%. Choose Outer Glow  

from the Styles list. Set the Blend 

Mode to Color Burn, lower the 

Opacity to 35%, click on the 

yellow color swatch, choose 

black as the color, and click OK to close the Color Picker.

Step Seven: Choose Drop 

Shadow from the Styles list. 

Set the Blend Mode to Color 

Burn and lower the Opacity to 

25%. Enter 2 px for Distance, 

2 px for Size, and click OK to 

apply the layer styles.

Step Eight: Command-click (PC: Ctrl-click) on the Layer 5 

thumbnail to load it as a selection. Now press Command-

Option-T (PC: Ctrl-Alt-T) to duplicate the selection and bring 

up the Free Transform bounding box. Move the duplicated 

metal bracket to the right side and press Enter to apply the 

transformation. With the duplicated bracket still selected, 

press Command-Option-T (PC: Ctrl-Alt-T) again and drag 

the copy below the gears. Continue this until you have 

brackets around each corner of the opening, and resize and 

rotate as necessary.

Step Nine: Open more images of metal plates, rivets, and 

lights. Select and place them into your original image. Resize 

and rotate the parts into place as needed. Use variations of the 

Outer Glow, Drop Shadow, and Bevel & Emboss layer styles 

that we used in previous steps to add more detail. When you’re 

done, click the Create a New Group icon (folder) at the bottom 

of the Layers panel. Select all of the layers of additional ele-

ments and click-and-drag them into the new group (Group 1).  

This helps keep your document organized.

Step Ten: Open an image of a gauge (one that has some 

type of piping attached works best). Using the selection 

tool of your choice, make a selection of the gauge and the 

lower portion of the pipe (see example). Switch to the Move 

tool and click-and-drag the selection into the steampunk  

document. Resize and reposition as needed. Click the Create 

a New Layer icon at the bottom of the Layers panel. Drag the 

new layer beneath the gauge layer in the Layers panel. 

Step Eleven: Command-click the 

gauge layer thumbnail to load it as 

a selection. With black as your Fore-

ground color (press D), press Option-

Delete (PC: Alt-Backspace) to fill the 

selection with black. Press Command-D 

(PC: Ctrl-D) to deselect. Press the Down 

Arrow key a number of times to move 

the black fill down (see example). Go to 

Filter>Blur>Gaussian Blur, set the Radius to 7 pixels, and click OK. 

Change the layer blend mode to Multiply, and lower the Opacity 

to 75%.

kelbyone.com
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Step Twelve: Open a vacuum tube 

or bulb image. Using the selec-

tion tool of your choice, make a 

selection of a single tube, switch 

to the Move tool, click-and-drag 

the selection into the steampunk  

document, and resize it. Follow Steps 

Two and Three to create a path and 

layer mask for the this image (see example), but don’t create 

the layer style from Step Three. Now click the Add a Layer Style 

icon and choose Inner Shadow. Turn off Use Global Light and 

set the Angle to 108°. Enter 7 px for Distance and 2 px for Size. 

Choose Inner Glow from the Styles list. Set the Blend Mode to 

Multiply. Click on the yellow color swatch, choose black as the 

color, and click OK. Enter 10 px for Size and click OK to apply 

the layer styles.

Step Thirteen: Add a new layer. Press 

D then X to set the Foreground color to 

white. Choose the Brush tool (B) from 

the Toolbox. Using a large, soft-edged 

brush, paint two white hot spots over 

the vacuum tube. Click the Add a Layer 

Style icon and choose Outer Glow. 

Click the yellow color swatch, choose a 

reddish color (R:239, G:72, B:39), and 

click OK. Enter 3 px for Size and click OK to apply the layer style. 

Change the blend mode to Overlay in the Layers panel.

Step Fourteen: When you change the blend mode, you’ll 

lose some intensity. To get that glowing-tube look back, simply 

duplicate the layer by dragging it onto the Create a New Layer 

icon to complete the effect. ■ 

In the final image, we added two other 
steampunked numbers, text, copper tubing, 
and some steam to achieve the mechanical, 

steam-engine effect we were looking for.

http://profoto.com/us/b1
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Dirty
Tricks

This project is the gift that keeps on giving. Not only can you 
make great one-of-a-kind wrapping paper, but this technique 
can also be used to make patterns for wallpaper or any other 
patterned background that you might want to design. 

it’s a wrap
B Y  P E T E  C O L L I N S

Step One: This is a vector image pur-

chased through Fotolia.com. If you 

aren’t comfortable using path-based 

images, don’t worry; inside the ZIP file 

of every download is a JPEG version of 

the image. Now you have the best of 

both worlds if you ever want to start 

playing around with vector graphics 

at a later date. 

Open the gift wrap image and 

choose Edit>Define Pattern. This 

works because the image is less than 

5,000-pixels wide and its background 

allows for easy tiling of the boxes.

[KelbyOne members may down-

load the file used in this tutorial at 

http://kelbyone.com/magazine/

issue/december-2014. All files are 

for personal use only.]

Step Two: Choose File>New to create a new document the size 

of the paper that you want to use: larger for print and smaller 

for the Web. When in doubt, it’s better to make it larger and 

reduce it than doing the reverse. For this one, create a 17x11" 

tabloid-size document at 300 ppi. The new document will open 

with a white Background layer that’s locked. Simply click on the 

lock icon in the Layers panel to unlock the layer, change it to a 

regular layer, and Rename it Layer 0. If you’d like to change the 

name of Layer 0, double-click on it and enter a descriptive name 

(we renamed ours “wrapping paper”). 

Step Three: Double-click to the right of the layer name to bring 

up the Layer Style dialog. Click on Pattern Overlay in the Styles 

list on the left, click the down-facing arrow next to the Pattern 

thumbnail, and choose the new pattern you created, which 

should be the last thumbnail in the menu. (You can use the Scale 

slider to change the size of the pattern, which is pretty neat.) 

Click OK to close the Layer Style dialog.

©
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Fotolia.com
http://kelbyone.com/magazine/issue/december
http://kelbyone.com/magazine/issue/december
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Step Four: You could stop right 

here and have fun playing with 

your new pattern, but if you want 

to use that pattern in another file 

or transform the paper to wrap 

around a box, its current form will 

constantly edit with every change. 

Press Command-J (PC: Ctrl-J) 

twice to make two copies of that 

layer with the pattern. Now select the top two layers in the Lay-

ers panel and press Command-E (PC: Ctrl-E) to merge those two 

together. Now you have set the pattern as a single layer that can 

be easily transformed. You can now cut out sections and wrap 

all kinds of presents.

Step Five: With your initial base sheet of patterns, there are 

plenty of options available; for example, you could simply make 

a copy of the layer (Command-J [PC: Ctrl-J]) and invert it (Com-

mand-I [PC: Ctrl-I]), or click the Create New Adjustment Layer 

icon (half-white, half-black circle) at the bottom of the Layers 

panel and choose Hue/Saturation to recolor it. 

Step Six: If you want to create a different pattern layout, return 

to the original download file to alter the pattern. Choose the 

Eyedropper tool (I) and click on the background color to sample 

it. Now choose the Rectangular Marquee tool (M), drag out a 

square over one of the boxes, and press Option-Delete (PC: Alt-

Backspace) to fill the selection with the sampled color. Now press-

and-hold Command-Option (PC: Ctrl-Alt) and click-and-drag 

the selection two boxes over to create an alternating pattern. 

Continue dragging the selection onto the remaining alternating 

boxes, and press Command-D (PC: Ctrl-D) to deselect. Now you 

can create a new pattern following the same steps as before, and 

the end result has a completely different look.

Step Seven: Up until now, we’ve been making simple patterns, 

but let’s get a little fancy. Instead of using the original image’s 

canvas, let’s make a new one that will make things easier for the 

remaining steps. You can make it any size you like as long as you 

can figure out the halfway point of both the width and the height. 

To make it easy, let’s create a new document that’s 4x4" at 300ppi. 

That means the midpoint for each side is 4 x 300 ÷ 2 = 600 pixels. 

You’ll understand why in a moment.

Step Eight: With the Foreground color set to the same color 

you sampled with the Eyedropper tool in Step Six, press Option-

Delete (PC: Alt-Backspace) to fill the document with that color. 

Choose the Rectangular Marquee tool and select one of the 

squares from the original image. Hold the Shift key while drag-

ging out the selection to constrain the proportion. This isn’t 

absolutely necessary, but helpful.

Step Nine: Now, while holding down the Shift key, use the 

Move tool (V) to drag-and-drop that selection to the new 4x4" 

document. If your rulers aren’t showing, press Command-R (PC: 

Ctrl-R), then drag out a horizontal guide and a vertical guide to 

the center of the document. Press Command-T (PC: Ctrl-T) to 

bring up Free Transform, press-and-hold Option-Shift (PC: Ctrl-

Shift), and click-and-drag on a corner handle to increase the size 

of the gift box from the midpoint, as shown. Press Enter to com-

mit the transformation, then press Command-J (PC: Ctrl-J) to 

make a copy of that layer.
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Step Ten: With the new top layer selected, choose Filter> 

Other>Offset to bring up the Offset dialog. This is where know-

ing the midpoint of your canvas will pay off. Make sure the Wrap 

Around option is on. Type 600 in both the Horizontal and Vertical 

fields. This will cut the image into four pieces and place quarters 

into the corners. You can play around with the sliders and get a 

feel for what’s going on, but the bottom line is if you plug in the 

halfway point of the image for both axes, it will do this. Click OK.

Step Eleven: Repeat Steps One through Four to make a new 

pattern. You can do this with any image if you understand the 

concept. Once you start playing with Offset like this, you’ll proba-

bly make a whole bunch of patterns. They may or may not come 

out a bit crazy, but that’s half the fun. 

Step Twelve: When you have your sheets of wrapping paper, 

one of the easiest things to do is cut out squares of the patterned 

paper with the Rectangular Marquee tool, use the Move tool 

to drag the selection to a photo or artwork that you’d like to 

gift wrap, and use Free Transform (Command-T [PC: Ctrl-T]) to 

manipulate the shape and size. For example, if you’re applying 

your wrapping paper to a box, Right-click in the Free Transform 

bounding box and choose Distort. Now drag the four corners of 

the paper onto the four corners of one of the sides of the box. If 

the box is white, then simply change the blend mode to Multiply 

in the Layers panel to take advantage of the shading, and voilà, 

you have a wrapped present.

Now that you have a better understanding of how to build pat-

terns, you can make your holidays bright and full of good cheer. 

Nothing like a quick way to create design elements that will make 

even the most Scrooge-like boss smile. Merry Christmas! ■ 
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DesignMakeover
C O L U M N  ›  ›

JAKE WIDMAN

“…the two agree that the  
company would benefit from  

something more contemporary.”

Jeanette and Vincent HoSang, immigrants from Jamaica of Chinese 

descent, started selling fried chicken along with Jamaican patties and 

bakery products at their store in the Bronx in the mid 1970s. The patty 

business took off, and they moved to a larger facility in the Bronx in 

1978; that was the beginning of the Royal Caribbean Bakery.

As the Jamaican patty business kept growing, it eventually sur-

passed the bakery business. The increased output required the 

company to move the patty production to a different, larger facility 

in 1994; they named the new operation Caribbean Food Delights. 

They’ve continued to grow and now have the capacity to turn out 

40,000 patties per hour.

However, their logo hasn’t kept pace with the sophistication of the 

business. “We didn’t think anything of it until I took an Adobe Web 

and graphic design course last year and showed our previous website 

to my professor,” says Simone HoSang, the founders’ daughter and 

the company’s director of nutrition and food science. The professor, 

Eugenio Solis de Ovando, advised HoSang that the logo was old- 

fashioned, too busy, and almost looked like clip art.

HoSang and company PR director, Janice Julian, do like some 

things about the logo—they think the red, gold, and green combi-

nation of colors suits the company’s Caribbean origins. Julian also 

likes that the logo is bright and reflects Jamaican spice and culture. 

Nevertheless, the two agree that the company would benefit from 

something more contemporary. Julian would also like to see a logo 

that projects longevity, resilience, and market dominance. “We are 

the number one manufacturer of Caribbean frozen food products,” 

she says.

We asked three designers to create a new logo for each branch of 

the company that would represent the company’s current success in 

the market while still respecting its “down-home” island roots.

royal treatment
I thought the original logos for the Royal Caribbean Bakery and 

Caribbean Food Delights were great at the time they were designed. 

But they’re somewhat crudely done and don’t take advantage of all 

the new features and filters Adobe Illustrator CS6 has to offer, which 

makes them look dated.

I wanted to take the company’s long history into account and 

respect the fact that their brand is very much established. I decided 

to work with the original vision and update it to bring out the true, 

current heart of the company. For example, I kept the existing crown 

for the Royal Caribbean Bakery logo, but I polished it with gold col-

ors, gradients, and rhinestones to really give it the royal treatment. 

The floral element on each side of the circle, reminiscent of money 

and valuable certificates, lends a sense of wealth. My font of choice 

was Trajan Pro, an elegant, classic display font.

For the Caribbean Food Delights variation, I decided to keep 

everything the same but replace the crown with a beautiful Carib-

bean beach (and change the words, of course). I used the Pen tool in 

Illustrator and my mouse to draw a palm tree leaf, which I then cop-

ied-and-pasted in at different angles to create the foliage. A simple 

curved line created the trunk.

For the sky, I wanted to go with colors that reminded me of an 

island sunset. I started by drawing a circle and added colors using the 

gradient feature. I did the same for the water. For the waves, I drew 

a stretched-out cloud and put spikes on its back to give it movement.

I used the same fonts and colors on the bottom of both logos. 

That way, they go together in a harmonious way.“I decided to work with the original 
vision and update it to bring out the 
true, current heart of the company.”

APPLICATION USED: Adobe Illustrator CS6

JOSE DACAL
Jose is the owner of Dacal Design, located in La Quinta, California. His love of art started at the age of 7 when he was brought into the 
family business, the Miami Billboard and Sign Company. That experience gave him a fascination for creating printed art, billboards, and sign 
manufacturing. On top of that, he learned how to operate large presses at the school of Graphics and Commercial Arts at Miami Lakes Tech.

Jose’s all-around knowledge allows him to understand every aspect of the business. He specializes in everything from creating branding for 
small companies to designing hundred-foot-tall billboards for the MGM Grand Hotel in Las Vegas. Besides 2D projects like logos and posters, 
he also designs vehicle wraps for cars and trucks. For more than 25 years, he has used his creativity, eye for detail, and ability to work quickly 
to satisfy his many clients.

about the designer

before

CLIENT
Royal Caribbean Bakery / Caribbean Food Delights 
www.royalcaribbeanbakery.com / www.caribbeanfooddelights.com

makeover submissions
WE’RE LOOKING FOR PRODUCT PACKAGING OR LABELS, PRINT ADVERTISEMENTS, WEBSITES, AND MAGAZINE COVERS THAT ARE CURRENTLY IN THE MAR-
KETPLACE FOR FUTURE “DESIGN MAKEOVERS.” SO IF YOU OR SOMEONE YOU KNOW HAS A DESIGN THAT YOU’D LIKE US TO CONSIDER MAKING OVER, OR IF  
YOU’RE A DESIGNER AND YOU’D LIKE TO BE CONSIDERED FOR A FUTURE “DESIGN MAKEOVER,” SEND US AN EMAIL AT LETTERS@PHOTOSHOPUSER.COM. 
(NOTE: THIS IS PURELY A DESIGN EXERCISE AND THE DESIGNERS DO NOT WORK DIRECTLY WITH THE CLIENT, CREATE FUNCTIONING WEBSITES, ETC.)

 ›  ›  D E S I G N  M A K E O V E R

DESIGNER
Jose Dacal 
www.dacaldesign.com

after

www.royalcaribbeanbakery.com
www.caribbeanfooddelights.com
mailto:LETTERS@PHOTOSHOPUSER.COM
www.dacaldesign.com
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My first experiments on this project included palm fronds that were 

drawn in Adobe Photoshop and vectorized with Vector Magic, but 

the final logo versions I chose were done entirely in Adobe Illustrator.

I experimented with colors other than the familiar red-gold-

green (and black-gold-green of the Jamaican flag), but I returned 

to this standard palette when it seemed to convey the brand more 

clearly. Also, after looking at their website for a while, I decided the 

slogan “Jamaican Me Hungry” called for the colors of the Jamai-

can flag instead of just the colors of sky, water, and tropical plants 

like I had been using, which could be appropriate for Hawaii or any 

number of areas.

The keywords that were suggested—especially longevity, domi-

nance, and the number one manufacturer of Caribbean frozen 

food products—all pointed toward retaining the crown from their 

existing logo, so I discarded my early drafts that featured gentle, 

relaxed palm fronds. I wanted the crown to be a simpler shape 

than the existing one, so it would be clearer when the logo is 

printed very small, and I wanted it to encompass the entire design.

The keywords also steered me toward replacing their existing 

fonts with a firmer slab-serif font, and I settled on Bevan, which 

was designed by Vernon Adams. This font also conveys the more 

contemporary feeling that the company wanted to reach. I concen-

trated on the central company titles, omitting the additional words. 

Those added phrases are important and descriptive, but I didn’t feel 

like they belonged directly inside the logos. The company now has 

the flexibility to place the additional phrases elsewhere, according 

to how much space is available on various packages, on their let-

terhead, website, and so on.

ERIC WILLIAMS
Eric Williams has worked as a designer, illustrator, and cartoonist for 30 years, and earned an A.S. degree in digital media from College of the 
Redwoods in Northern California in 2006. After graduation, he set up shop in Humboldt County, California—home of the giant redwoods—and 
continues to work mostly with clients in that area.

Eric creates logos, illustrations, websites, and custom comics, as well as advises clients about copyrights, trademarks, and branding. Some 
projects are done digitally from start to finish, while others begin with pencil and paper. Specializing in carefully vectorized adaptations of public 
domain art, he brings attention, whenever possible, to forgotten cartoonists and illustrators whose work lingers like ghosts in the forgotten 
corners of the vast spaces of the Internet. In his free time, he works on assorted projects, including comics, writing, animation, and 3D graphics.

APPLICATION USED: Adobe Illustrator CS5

Caribbean Food Delights and the Royal Caribbean Bakery say 

they’re the number one manufacturer of Caribbean frozen food 

products, and they’ve been in business for more than 36 years. The 

goal here is to design a new identity that represents the company’s 

strength and supremacy. I set out to create branding that could be 

instantly recognized with a strong presence on their packaging and 

also on the Web, as well as a flexible mark that could work both in 

print and online to ensure brand recognition across different media.

The existing branding is old-fashioned, there’s too much going 

on, and the logo is used inconsistently in different media. My solu-

tion is to create two different lockups for the logo mark and the 

brand typography. The first lockup has the logo mark on the left 

and the brand type on the right, and the second lockup puts the 

logo mark on top with the type on the bottom. This way, the iden-

tity is flexible—the arrangements and brand names can be mixed 

and matched as appropriate.

I chose to continue using a crown because it communicates roy-

alty and leadership. The company wants to be the leader of manu-

facturing Caribbean foods. I also chose to incorporate their main 

product, the patty. The patty also represents a person wearing the 

crown and seems to be smiling, too.

As for the colors, I decided to keep the same colors that are used 

in their current logo—red, yellow, and green. I felt that these colors 

best represented the Caribbean theme. Also, it will be easier for the 

customers to recognize a new identity if the colors are the same as 

the ones they’re already familiar with.

For the typography, I used a sans-serif font, Refrigerator Deluxe. 

It’s a neutral, easy-to-read font that works well for their packaging 

and on their website.

APPLICATION USED: Adobe Illustrator CC

MICAEL BUTIAL
Micael Butial is a passionate designer who is studying graphic and Web design at The Art Institute of California—San Francisco and will gradu-
ate December 2014. He also works as a visual designer intern at Switch Communications in San Francisco.

Micael grew up in the Philippines and started painting portraits at a young age. After moving to the United States, he continued painting 
at a local theme park and then decided to pursue a career in the art industry. Micael’s top skills are typography, branding, and illustration. His 
works have been featured in The Dieline, AIGA Member Portfolios, Serifs & Sans, and in the CSS Design Awards. In early 2014, Micael won 
an award and scholarship from the Hyatt hotel chain for a design that will be featured on their Canvas Merlot wine. Micael is seeking a career 
in design in the technology sector and hopes to open his own design firm in the future. ■ 

about the designerabout the designer

“I wanted the crown to be a 
simpler shape than the existing 

one, so it would be clearer when 
the logo is printed very small…”

“…the identity is flexible— 
the arrangements and brand 

names can be mixed and 
matched as appropriate.”

DESIGNER
Eric Williams 
www.luminousrobots.com

after

D E S I G N  M A K E O V E R  ›  ›  ›  ›  D E S I G N  M A K E O V E R

DESIGNER
Micael Butial 
www.behance.net/micaelbutial

www.luminousrobots.com
www.behance.net/micaelbutial
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C O L U M N  › ›

ADOBE MAX WRAP-UP: A GUIDE TO ADOBE’S  
GROWING LIST OF WEB-DESIGN PROGRAMS

Janine Warner

From the ever-popular Dreamweaver, which is coming up on its 20th birthday, to designer-friendly Muse, 

which is just coming of age, to the new collection of Edge tools, it’s clear that Adobe has made Web and 

mobile design a high priority.

› › B Y  D E S I G N

A significant number of websites begin life as layered 

PSDs and the Extract Assets feature is designed to stream-

line the process of turning those PSD files into optimized 

images, HTML, and CSS code. Last year, Adobe added 

Generator to Photoshop, which made saving images for 

the Web faster and more efficient because you can use 

it to turn any layer in Photoshop into a GIF, PNG, or JPEG 

by simply selecting Generate from the File menu and then 

adding the corresponding extension to the layer name. 

(For detailed instructions, see my article in the November 

2013 issue of Photoshop User, p. 102.)

The new Extract Assets feature takes the process a 

step further by making it possible to optimize images 

even more efficiently, and to extract code snippets from 

Photoshop, which can then be pasted into almost any 

other Web program to re-create complicated design  

elements, including gradients and drop shadows. 

INTRODUCING THE NEW PHOTOSHOP 
EXTRACT ASSETS FEATURE
There are a few programs on the market (not from 

Adobe) that claim they can convert a layered PSD into 

HTML and CSS code automatically, but I’ve found all of 

these tools disappointing because interactive websites are 

too complex to be generated automatically, even from 

a well-crafted PSD. What’s great about the new Extract 

Assets feature in Photoshop is that it doesn’t even try to 

automatically convert entire layouts. Instead, it’s designed 

to assist in the tedious process of turning a layered file 

into optimized images that can then be reassembled in a 

Web-design program like Dreamweaver or Muse. 

‘‘

‘‘

 B efore I explore the pros and cons of each of 

these programs and their latest enhancements, 

I have to say that what got Web designers most 

excited at this year’s Adobe MAX conference was the new 

Extract Assets feature in Photoshop, which makes it easier 

to generate optimized images and code snippets from a 

PSD file. It’s not an exaggeration to say that this one new 

addition to Photoshop (which is also integrated into Dream-

weaver) could save Web designers thousands of hours of 

tedious work.

What’s great about 
the new Extract 
Assets feature in 
Photoshop is that it 
doesn’t even try to 
automatically convert 
entire layouts.
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Using Extract Assets to get snippets of code out 

of a PSD, such as the CSS needed to create a gradi-

ent or drop shadow, is far more useful than trying 

to automatically convert an entire page. Most of the 

tools that try to do that cheat and turn gradients 

into images. Using CSS, you can create gradients 

that download much faster and are more efficient 

to edit if you want to change them later.

USING EXTRACT ASSETS  
IN DREAMWEAVER
Despite growing competition in the increasingly 

fragmented Web-design market, Dreamweaver 

continues to enjoy strong support among Web 

designers, and Adobe has made a major invest-

ment in the program in its latest update, rebuilding 

the entire code base to upgrade it from a 32-bit to 

a 64-bit program. When you launch the latest ver-

sion of Dreamweaver, the most dramatic enhance-

ment to the interface is the addition of the Extract 

window, which takes up the entire left third of the 

program’s interface. 

Even if you don’t have a copy of Photoshop 

on your computer, you can use the Extract win-

dow to upload any PSD file to Creative Cloud by 

clicking on Upload PSD (the big plus sign). It took 

about 3 seconds over my cable modem for the 

layered PSDs shown in these figures to upload and 

become available in Dreamweaver. Adobe uses 

the Cloud to transfer the files to Dreamweaver, 

and you must have an active Creative Cloud 

account to use this new feature.

You can upload multiple PSDs and switch from 

one to another by clicking on its thumbnail. Once 

a PSD is loaded, you click on any layer (or folder of 

layers) to extract it as an image and save it directly 

into your website folder in Dreamweaver. You can 

also copy colors, text, and code snippets out of the 

PSD and then paste them into any open file in the 

main workspace. 

Among other improvements to Dreamweaver, 

the Live View feature now displays webpages 

more accurately, and you can do more editing 

from Live View, which makes design and testing 

much more efficient.

After teaching and writing about Dreamweaver 

for nearly two decades, I’ve come to appreciate its 

rich set of features, but I understand that many 

designers find Dreamweaver daunting and are 

delighted by the more designer-friendly interface 

now offered by Adobe Muse.

B Y  D E S I G N  › › › › B Y  D E S I G N

The new Extract Assets feature in Photoshop  
could save Web designers many hours of work.

The new Extract window in Dreamweaver  
takes up about a third of the interface.

With Dreamweaver and the Creative Cloud, you  
can quickly extract PSDs, as well as copy colors, text,  

and code snippets out of PSDs.

In Muse, it’s easy to generate a series of pages  
and see how they are related to one another.

THE DESIGNER’S MUSE
If you’re a fan of InDesign and can’t stand the idea of having to 

learn HTML to create a website, Muse is for you. In just a few 

intuitive clicks, you can generate a series of pages in Muse and 

view them in a way that makes it easy to see how pages are 

related to one another. 

Although there’s no Extract Assets panel in Muse (at least 

not yet), you can still benefit from the ability to more easily 

generate assets from Photoshop that can then be used to cre-

ate your designs in Muse. 

Because Muse is a design tool, not a programming tool, 

many designers find they can skip the step of creating the ini-

tial design in Photoshop. Indeed, some of my friends who are 

professional Web designers have found that Muse is a great 

way to quickly mock up an interactive website, even if they 

plan to use Dreamweaver or a content-management system 

to build the final site. (Don’t get me wrong, they don’t use the 

code from Muse in the final websites, but it’s a nice tool for 

creating interactive mockups.)

If you look under the hood, you’ll find that the automatically 

generated code that’s exported from Muse is not as efficient 

and easy to edit as most programmers would prefer, and you 

couldn’t even edit the code in Muse if you wanted to. There’s an 

Export feature that spits out the code or sends it directly to your 

Web host when you’re ready to publish.

If code isn’t your concern, the design features in Muse are 

a joy to work with and you can use it to create highly inter-

active, modern websites, complete with parallax scrolling and 

simple animations.

BEHANCE: NOW MORE THAN  
4 MILLION STRONG
Front and center at the Adobe MAX keynote was the Behance 

online creative community, which now boasts more than 4-million 

registered users. Although it may not be the first place you think of 

when you consider how to create a website, you can create more 

When you’re ready to publish your website that  
you created in Muse, you can export it as HTML.
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B Y  D E S I G N  › › 

ALL IMAGES BY JERRY STOLL

than a simple portfolio if you upgrade to Behance Pro, which is 

included in the full Creative Cloud subscription.

If you’re among the millions of designers, illustrators, and 

photographers using Behance to showcase your work, you 

may be pleased to learn that you can easily integrate your 

Behance portfolio into a Behance Pro website. The pro version 

of Behance includes only a few basic layouts, but the edit-

ing features enable enough customization to create a unique 

design if all you need is a portfolio site. 

WHAT ABOUT ALL OF  
 THOSE EDGE TOOLS?
Despite the common name, the collection of programs named 

Adobe Edge don’t all work together, and none of them are well-

suited to creating a website from start to finish, but they can 

provide some specialized assistance when you need it.

Amid this new crop of tools, Edge Animate is the most 

mature program and the one I find most exciting. You can 

use Edge Animate to create interactive HTML5 animations, 

complete with CSS and JavaScript (and you don’t have to 

write any code yourself).

The heart of the program is a Timeline that takes up the 

bottom third of the interface. If you’ve used Adobe Flash, 

you’ll have an advantage with Edge, although the two pro-

grams are quite different in many respects. Animate is ideal 

for creating interactive features that can then be exported 

and integrated into Muse, Dreamweaver, and other Web- 

design programs.

Edge Inspect is a cross-browser testing tool that can help 

ensure your Web and mobile designs work across different 

devices. Using Inspect, you can wirelessly connect smart-

phones and tablets (iOS and Android) to a computer and then 

update, view, and test the same page on all of the devices at 

once. This type of testing environment is increasingly import-

ant as more and more people surf websites on mobile devices.

Edge Code is, as the name implies, designed for writing 

and editing code. It’s still in Preview, which means it’s not yet 

a fully released program. You can download it for free from 

www.adobe.com. Edge Code is a nice little code editor and 

shows promise, but it was notable that there seemed to be 

more people at Adobe MAX talking about the increasingly 

popular Brackets, the open-source project that Adobe used as 

the basis for Edge Code.

Edge Reflow (also still in Preview) was designed to create 

responsive Web designs, but after a fair amount of testing,  

I have to say this tool isn’t ready for professional use. Although 

it seems enticing that you can automatically generate a web-

page from a PSD using Reflow, you can only generate one 

page layout at a time, which is limiting when you consider that 

most responsive websites include at least three designs: one 

for desktops, one for tablets, and one for smartphones. 

THE BEST WAY TO CREATE 
A WEB GALLERY
Over the years, I’ve asked numerous people at Adobe what 

they recommend for quickly and efficiently creating beauti-

ful photo galleries on the Web, but I’m sorry to report I still 

haven’t gotten a good answer. There used to be a Web gal-

lery feature in Dreamweaver, but it was removed years ago. 

Ditto for Photoshop. You’ll find a gallery feature in Lightroom, 

which isn’t a bad way to quickly generate a gallery of images 

to post to the Web, but I find it flawed for two key reasons. 

First, the best design options in Lightroom require Flash, and 

most Web designers no longer use Flash because Flash files 

don’t display on iPhones or iPads. Second, the HTML galleries 

you can create in Lightroom can’t easily be integrated into an 

existing website. By that, I mean you can’t insert a Lightroom 

gallery into a page created in Dreamweaver, Muse, or any 

other Web program. You can create simple, standalone gal-

leries, which is a handy way to share proofs with clients, but 

the gallery feature in Lightroom isn’t a good way to create 

a portfolio of your images if you want to add them to your 

website or blog.

When I asked the photographer who was hired to photo-

graph the Adobe press party how she was planning to post 

all of the photos she was taking, she said I could find them 

on Flickr. ■

Behance Pro allows 
you to customize 
your portfolio so 
you can create a 

unique design.

www.adobe.com
http://shop.tallscamera.com
http://www.huntsphotoandvideo.com
http://lansingcamera.com
http://www.bhphotovideo.com
http://www.adorama.com
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These are my self-imposed guidelines for which products make it into the 
guide. It’s just two rules actually. First, to be listed here they have to be 
products that I use myself, and that I absolutely love, and now can’t live 
without (well, I could live without them, but I wouldn’t want to). Second, 
if a product makes the guide, it has to be one I would recommend to a 
close friend without hesitation, especially if my friend is a personal injury 
attorney (kidding). 

elcome to my “9th Annual Gonzo Holiday Gear Guide” (yes, last year I brought the “Gonzo” back after a 
brief break because just calling it a “Holiday Gear Guide” lacked that certain, I dunno, “gonzoness.”) So,  
I now bring you my “Gonzo Holiday Gear Guide” whose light burns brighter than a thousand suns (in-
sert dramatic pause here), featuring an unbridled collection of 100% absolutely necessary gear that 
there’s no way we can see clear to live another minute of our hopeless, desperate lives without. (I gotta 

tell ya, you have to search far and wide to find any holiday gear guide that uses the terms “hopeless” and “desperate” 
in the opening paragraph, which is more irrefutable proof that this guide truly stands alone.) 

Before we get to the list, remember that the holidays aren’t about which gifts you get. They’re about how many 
gifts you get, and the person who dies with the most gifts wins. (By the way, you can now add “dies” to “hopeless” and 

“desperate,” making this the most riveting of all gear guides ever!) Also, to make things easy, we put up a webpage (www 
.scottkelby.com/14gear) with direct links to all the products I picked so you don’t have to wonder if you’re getting the 
exact right one. Okay, folks, watch your Geschwindigkeitsbegrenzung, because here we go!

This is one of those gifts that every 
photographer at one time or another will 
need, but it’s one of the last things we 
think to buy, which is what makes it such 
a great gift. You’ll need to know the make 
and model of his camera so you get the 
right type of connector. Prices start at 
around $18 for a Nikon or Canon wireless 
release. Sadly, the better DSLR he has, the 
more the cable release that works for that 
camera costs, so just hope he has a lower-
end model. 
www.bhphotovideo.com
Price: Starting at around $18

If the photographer on your holiday list has a printer, this is a gift she 
will truly love because you can never have enough paper (or ink for 
that matter). Recently, I saw some absolutely beautiful papers from 
Freestyle Photographic Supplies when I was at Photoshop World in 
Vegas. If she’s into black and white, you can get an Adox Premium 
MCC 110 VC FB 8x10/5 Sheet Sample Pack for $8.99. Sweet!
www.freestylephoto.biz Price: Starting at around $8.99

In sacred Gonzo tradition, I’m breaking things into three distinct categories: 

  You can also use these as actual holiday gifts if you’re 
not that crazy about the person. 

  Stuff that’s a really good deal for not a lot of money, 
but he or she will totally dig it.

  Stuff you buy for the doctor/petroleum engineer/rap mogul 
on your holiday gift list. This is the stuff that makes them burst into spon-
taneous tears of joy. Well, at least I would.

www.scottkelby.com/14gear
www.bhphotovideo.com
www.freestylephoto.biz
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This is a really great stocking stuffer because your 
photographer will love it. They’re awesome because they 
save space while protecting her lens from damage and lens 
flare, and it looks like it costs a lot more than it did. They start 
at $4.95. Of course, the price depends on the size of her lens 
measured in millimeters. For example, a typical 70–200mm 
lens uses a 77mm size lens hood, which is still only $19.95 at 
B&H Photo if you buy the B+W brand, and less than half that 
if you buy the General Brand lens hood.
www.bhphotovideo.com Price: Starting at $4.95

I love this stocking stuffer because even if he has a spare battery, he 
would still love another one. It’s one of those can’t-go-wrong stocking 
stuffers. They’re usually fairly inexpensive (from around $40–60), unless 
of course, he has a high-end camera like a Canon EOS-1Dx ($165) or 
a Nikon D4s ($149), in which case this gift may test the limits of your 
friendship. Just sayin’. 
www.bhphotovideo.com Price: Starting at around $40

The king of black-and-white conversion plug-ins had always been Nik Software’s Silver Efex 
Pro (now part of the Nik Collection by Google), and it’s still a great plug-in, but there may be 

a new king in town. Macphun has created 
a killer black-and-white conversion tool at 
less than half of the price of buying the Nik 
Collection. The Pro version is $69.99 and 
it totally kicks butt! If your photographer 
is into black and white, this will become 
her new tool of choice. (The only caveat 
is that it’s Mac only, so make sure she uses 
a Mac first.) 
http://macphun.com Price: S69.99

There are a lot of great flash modifiers out there, and MagMod 
is a new player in this market, but I gotta tell ya, their magnetic 
system of flash modifiers is so incredibly easy to use that you’ll 
be a hero when the photographer on your list uses this system 
for the first time. The MagMod Basic Kit is $89, which comes 
with the MagGrip, MagGrid, and MagGel (magnetic—it just 
pops on and off) but then you (or he) can buy accessories 
fairly inexpensively like $19 for the Creative Gel Set or $25 for 
the MagGel 2 Slot Kit. Cool stuff! 
http://magnetmod.com Price: Starting at $89

It’s a four dual-wheel roller camera bag that she will absolutely go bonkers over! It holds a 
ton of gear, and it glides through the airport like it’s on rails. Lots of room for lots of gear, 
and a very well-thought-out bag all the way around (plus, it fits in the overhead bin with 
no problem). However, fabulous eight-wheeled bags don’t come cheap: it’s around $390. 
Give it to someone you love, or someone you want to love you who doesn’t yet, but will 
after you give her this. 
www.thinktankphoto.com Price: $389.75

He will love Night Photography: From Snapshots to Great Shots  by Gabriel Biderman and Tim Cooper (around $16 on Amazon), 
or how about Matt Kloskowski’s awesome eBook Landscape Photography Workflow Using Lightroom and Photoshop for $9.99 on 
Amazon. (It’s an eBook for Kindle or the Kindle app on your tablet or smartphone.) Hey, he might like my new book, part 5 of my 
The Digital Photography Book series (just $15.80 on Amazon in print or $9.99 for the eBook version), or if you want to splurge a 
little (and he shoots portraits), get him Picture Perfect Posing by Roberto Valenzuela (around $30 at Amazon). 
www.amazon.com Price: Starting at $9.99

www.bhphotovideo.com
www.bhphotovideo.com
http://macphun.com
http://magnetmod.com
www.thinktankphoto.com
http://www.amazon.com
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I learned about this strap about four years ago on one of my photo 
walks and I’ve been using one ever since. The strap wraps across the 
body (great for safety since a thief can’t just grab it off your shoulder 
and take off), and the camera hangs upside-down at the side ready 
to slide up the strap and shoot at anytime. Really can’t say enough 
about ’em. Around $62 at B&H. Totally worth it. 
www.blackrapid.com Price: $61.95

These are so inexpensive it probably should have been listed under 
stocking stuffers, but don’t let the low price fool you—these puppies 
work amazingly well. They’re used for firing your flash or strobes 
wirelessly and they do a great job of it, even if they’re not the prettiest 
wireless units out there. A set of two is around $75 (and yes, he’ll need 
two—one goes on top of his camera in the hot-shoe mount, the other 
attaches to the flash itself ). 
www.cactus-image.com Price: $74.95 for two

It’s never been more important to have an online portfolio, 
and SmugMug’s gorgeous, newly designed templates have 
taken the world by storm. If the photographer on your 
holiday list doesn’t have an online portfolio yet (or if she does 
and she has dreamed of selling her work online), this is the 
ticket. Their Basic plan is just $40 for a year—so get her a year 
plan. She’ll love you for it!
www.smugmug.comm Price: Starting at $40/year

I started using one of these British tripods this year and I really 
love it, and the photographer on your gift list would totally 
love one, too! It makes an awesome travel tripod and it comes 
with a ballhead. It has reversible legs so it folds up really small, 
and it’s super lightweight, but amazingly sturdy. B&H carries it 
for $199. You’ll get lots of love in return.
www.3leggedthing.com Price: $199

This is one of those gifts that he will love you for forever because it’s 
so handy, and it will make his camera look and feel more like a high-
end pro camera. It also gives him a second battery holder and a 
shutter button for when he’s shooting vertical. They start at around 
$50 for a third-party grip, but if you buy a Nikon or Canon brand, 
expect to pay at least two to three times as much, so give the Vello 
brand at B&H a serious look. You’ll be a holiday hero for this one! 
www.bhphotovideo.com  Price: Starting at $49.95

Want to really make a photographer lose her mind? Gift 
her one of her own images printed on metal—it’s like 
seeing her image in HD for the first time. Just remarkable! 
(By the way, this isn’t metallic paper; this is printing on 
actual metal.) MPIX rocks at these metal prints and you 
will rock for giving them. They start at $33.99 for an 8x10 
(the 12x18 is a good deal at $59.99).
www.mpix.com Price: Starting at $33.99

Scott Kelby

www.blackrapid.com
www.cactus-image.com
www.smugmug.com
www.3leggedthing.com
www.bhphotovideo.com
www.mpix.com
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Not sure exactly what to get him? Yes you do. Get him 
a B&H Gift Card. I don’t know anyone who doesn’t want 
something from the greatest photo store on earth, plus 
this way he can get whatever he wants (within the limit 
of how much you put on the card, of course). You can 
order them directly from the B&H site. They send a card 
and a catalog so it looks pretty substantial.  
www.bhphotovideo.com Price: Starting at $20

For around $120, you can get her a one-year subscription to Adobe’s 
Creative Cloud Photography Bundle where she’ll get the latest versions of 
both Photoshop and Lightroom, plus Lightroom mobile (for iOS), as well as 
some other goodies. Love will rain down upon you for this gift!
https://creative.adobe.com/plans/photography Price: $119.88

Every photographer who shoots studio strobes on location dreams 
of two things: working on location without hauling around a 
battery pack, and shooting Profoto gear. The new Profoto B1 500 
AirTTL fills both dreams at once because the battery is built into 
the sleek body (so no hauling a separate battery pack around). 
Profoto is the cream of the crop for performance, and they’re gear 
is built like a tank (which is why most rental houses offer Profoto as 
their main line). But the price of the B1 500 AirTTL isn’t for just anyone 
at $1,995—definitely for pros or for the Wall Street insider on your holiday 
gift list. 
http://profoto.com Price: $1,995

This is a very important and powerful gift because this will house your holiday 
photographer’s entire photo collection in a safe, rock-solid storage system (the same 
one I use myself), plus it will give her access to her images no matter where she is (via 
the Web). I’ve been looking for a kick-butt backup and archive system for years, and this 
is the one! A totally mind-blowing gift. Use their NAS Selector to find out which one is 
right for the photographer on your list. This may be one gift where you tell them up 
front, “I’m getting you a Synology NAS,” so you get the right one for her needs (and the 
outpouring of unconditional love may start before the actual holiday does). 
www.synology.com Price: Starting at around $380

I know I’ve been something of a cheerleader for this camera since 
Canon announced it in late September, but it’s because I think Canon 
did something really special with this camera aimed at sports and 
wildlife shooters. They put pro specs into an affordable camera body, 
so you no longer need to have NFL-sideline-quality gear just to get 
great photos of your kids’ high school sporting events. With 10 frames 
per second, a 20.2-megapixel sensor, and much improved high-ISO 
noise performance over the older 7D that it replaces, I think it’s an 
amazing camera at a brilliant price. He will follow you around like a 
puppy for the rest of his life if you buy him this. 
www.usa.canon.com Price: $1,799

While this isn’t nearly the most expensive gift in this gear guide, it’s the 
biggest, so it may have the most physical impact. It’s quite properly named 
because this mammoth softbox will give you maximum impact as it slowly 
casts a shadow over the studio space. Okay, I may be overdramatizing the 
size, but not the impact. Through a clever design, this new softbox allows you 
to focus and shape the beautiful light by sliding the actual strobe inside the 
softbox. She will love you for it. Westcott Zeppelin lights cost $399.90 for the 
35" model; $499.90 for the 47" model; and $699.90 for the 59" model, which 
looks like it’s the actual size of the Goodyear Blimp when you see it live.  
www.fjwestcott.com Price: Starting at $399.90

www.bhphotovideo.com
https://creative.adobe.com/plans/photography
http://profoto.com
www.synology.com
www.usa.canon.com
www.fjwestcott.com


› 
› 

p
h

o
t

o
s

h
o

p
 u

s
e

r
 ›

 d
e

c
e

m
b

e
r

 2
0

14

064

The popularity of these DJI copters is exploding because, quite simply, they 
let your camera fly in the air for stills or video, and photographers have 
absolutely flocked to them in the past year. This isn’t just photography, this 
is fun! It’s $1,229 with a spare battery, and it’s worth every single penny. This 
may be the coolest gift ever. 
www.dji.com Price: $1,229

 
Wanna give him a gift that he’ll remember all year long? How about world-class online training on 
everything from Photoshop to Lightroom to photography? It’s $249 for an entire year (with 24/7 
access to literally thousands of lessons), or just $25 a month. Not only will he love you for it, so will I.   
http://kelbyone.com Price: $249/year; $25/month

The name says “for designers,” but since just about every project in 
the entire book starts with a photo, it’s really a special effects book 
for designers, photographers, or anybody who wants to learn how to 
create amazing effects in Photoshop.  
http://kelbyone.com Price: $33.99

Buying someone a ticket to one of these full-day seminars would make an awesome gift. My “Shoot Like a Pro” tour, Matt 
Kloskowski’s tour for learning Lightroom, or Joe McNally’s “The Power of One Flash” tour are among the choices.  
http://kelbyone.com Price: Starting at $89; $79 per person for groups of five or more

Give him a full conference pass to the Photoshop World Conference & Expo. It’s a 
three-day Photoshop, Lightroom, and photography love-fest. If you buy it for him 
now, you can get $100 off with the Early Bird discount. If you want to get a one-
day pass instead, it’s just $249.  
http://photoshopworld.com Price: Starting at $599

  
This is the lens I use as my all-around travel photography lens. It’s lightweight, compact in size, 
and you can’t beat the price as far as value goes. Will it be the sharpest lens in his bag? Nope. Will 
it be the lens he turns to again and again because it covers everything from wide-angle to super-
telephoto? Yes it will. Will you be showered with affection for giving a lens as a gift? Yes you will.
http://www.tamron-usa.com Price: $849

www.dji.com
http://kelbyone.com
http://kelbyone.com
http://kelbyone.com
http://photoshopworld.com
http://www.tamron-usa.com
http://www.portraitprofessional.com
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A
s photographers, we want to invest in the gear 
that will give us the best images possible. From 
cameras to lenses to tripods—they all incremen-
tally get us closer to reaching our photographic 

potential. Once the captures are complete, we take all of 
those images and store and process them on a computer. 
What we don’t often see is that the computer can be the 
most important piece of the puzzle.
 This is usually the time of year that everyone starts 
considering a refresh of their computers, so I thought it 
would be a good time to let you know what kinds of things  
I consider when purchasing a new Photoshop machine. This 
will not be an extensive technical dive into technology, but 
more of an anecdotal brushstroke of the things I consider 
and use. If it can work for me with the amount of Photoshop 
and video work I do, then it could be a good start for you.

WHICH IS BETTER, MAC OR PC?
The Mac vs. PC argument is one of the most polarizing arguments out there. Writing about it will almost certainly gener-
ate some letters to the editor saying, “How dare you? RC got this all wrong!” I think this is one of the most fundamental 
questions that should be answered by you when purchasing a computer—and this answer is largely shrouded in hype. 
 These days, there are no discernable differences between PCs and Macs, aside from the operating system. The apps run 
exactly the same. If you use an iPhone, iPad, or AppleTV, you might find using a Mac is better as all the devices will be in the 
same ecosystem. If this isn’t a concern, then you’re right back to operating system preference. There’s no other difference. 
 To help as many people as possible, I work on both PCs and Macs, so I know either of them can do the job. (If you 
were to ask me my preference, though, I’m a PC guy at heart.)

THE PROCESSOR: THE  
BRAINS OF THE MACHINE
One of the most important parts of the computer is the processor 
chip that runs the machine. This is the brain that will handle all of 
the tasks in Photoshop, encode videos, and be responsible for a lot 
of the heavy lifting of the files you throw at it.
 I’m a big fan of the new Intel Core i7 Processors. These chips are 
based on a quad-core architecture. Think of each of the cores as 
a little brain. The more cores you have, the faster the work can be 
tackled. Recently, Intel refreshed their chips to the 4th Generation 
Core i7, offering even faster processing across those four cores. 
With features such as Hyper-Threading, which allows each core to 
work on two tasks at the same time, this means more power.
 While overall processing power is important, it’s the electrical 
power consumption where you’ll see the dividends pay off. Pre-
viously, most PCs were rather large and carried extremely large 
power supplies. This made them hard to transport, and they would 
get incredibly hot. I could only work for a short amount of time—
maybe two hours max. The 4th Generation Core i7s are really good 
at handling power and battery life. Most laptop power supplies are 
now a lot smaller and not as unwieldy. 
 I was using a Samsung laptop with the new Intel processors on 
a recent trip. I started working on files on a plane from Tampa to 
Atlanta—about an hour trip. On my next flight from Atlanta to Los 
Angeles, I was pushing multiple files through Photoshop. When it 
was time to turn off the laptop for descent, about 3 1/2 hours in,  
I still had about 20% of battery left. (For the latest Samsung laptop, 
check out the the ATIV Book 9 at http://bit.ly/1t8Yv2q.)
 Real processing punch, great power management and battery 
life, and small power supplies are invaluable in your Photoshop 
machine, in your home or on the go, so invest in a machine with 
the new 4th Generation Core i7 Processor. You’ll be glad you did.

RAM: 8 GB OR MORE
The next major component to consider for your computer is the 
amount of RAM that you’ll need. While the brains of the computer 
usually help with processing your files, it’s RAM that manages all 
the applications running on your machine. The more RAM you can 
put into a machine, the better. I’ve been able to successfully run 
a majority of my Photoshop tasks on 8 GB of RAM, but I like to 
upgrade to 16 GB of RAM whenever possible. This will help me a 
lot as I work with Photoshop and video. 
 There are different types of RAM speeds available. I find that 
more often than not the RAM speed doesn’t make that much of a 
noticeable difference in Photoshop work. Keep the RAM speed low 
if you have the option and save yourself the extra money.

HARD DRIVE SPEED & SSD DRIVES
When you shoot images, you’re going to need to store them. It’s 
obvious that the more speed you have on your machine, the bet-
ter; however, you’ll also notice a performance boost the faster that 
information gets in and out of the machine. For that, you’ll need to 
address the hard drive speed. 
 Hard drives are physical disks that sit in your machine. These 
platters are read by a needle. The faster the platter spins, the faster 
the computer can read the data. This is usually measured in revolu-
tions per minute (RPMs). 
 Generally, you’ll find two speeds in hard drives: 5400 RPM and 
7200 RPM. I recommend the faster of the two drives whenever pos-
sible. In fact, I would get a smaller, faster drive vs. a larger, slower 
drive. Most of my images live in external drives, so I can live with 
the smaller drives. On a desktop computer, it’s much easier to find 
large hard drives in the 7200-RPM range. 

What about SSD?
Solid-state drives (SSD) are coming into their own. If you have an 
iPhone, iPad, or tablet, you’re already using this technology. Rather 
than a spinning platter and a needle to read the data, data sits on an 
integrated circuit. There are no moving parts, so battery consump-
tion is usually better, and reading the data is generally faster. This is 
usually the best option on a fast-running computer (standard on a 
MacBook Pro with Retina display), but they tend to get a little pricey. 

Use a Scratch Disk
This may only apply to desktop systems or really expensive laptops, 
but it definitely bears mentioning. If you’re manipulating really large 
files, then get a computer that has multiple hard drives onboard. 
Having a second hard drive will let you assign a drive as a scratch 
disk. When Photoshop uses all the available RAM on your comput-
er, it will temporarily switch to using a hard drive as virtual memory, 
commonly known as swap space. Having a dedicated drive for the 
swap space can make a difference in how well your computer runs.

LAPTOP OR DESKTOP?
Once you’ve selected your operating system, you need to focus on whether you’ll want 
to use a laptop or a desktop for processing. History dictated that desktop systems 
were usually better for processing large files. The downside was portability. I’ve been 
shooting with cameras in the 12–36 megapixel range and making multilayered files, 
and the laptops I’ve been using (see “My Computers”) haven’t had a significant hiccup 
with any file I’ve thrown at it.
 If you get into pro video production; working with higher resolution files, such as 
panoramas; or working with 3D, you would be best served investing in a desktop sys-
tem. For photographers, I would argue for a mobile machine paired with a great dis-
play. This gives you the best in power and mobility, and lets you upgrade the display as 
needed. You should also always check the minimum and recommended system specs 
for the applications that you want to run. For the official requirements for Photoshop 
CC 2014, visit http://helpx.adobe.com/photoshop/system-requirements.html.

PHOTOSHOP & 
HARDWARE:

SELECTING THE  
RIGHT EQUIPMENT

by RC Concepcion

MY
COMPUTERS

These are the laptops that I’m currently using:
    •  MacBook Pro with Retina display

 •  Razer Blade 14" touchscreen
 •  Samsung NP700Z5C - S02US
 •  Toshiba Satellite P50T Ultra HD 4K touchscreen laptop 
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VIDEO MEMORY
Photoshop is a resource-intensive program, but unless you’re doing 
a lot of 3D work, a good video card with about 1 GB of RAM will be 
more than adequate. Most recent chips have an onboard graphics 
processing unit (GPU), and that could be suitable. To use all of the 
GPU-enabled features in Photoshop, opt for a computer that has a 
separate video card built in (you’ll hear this referred to as a discrete 
video card). If you want to refer to a listing of GPU features for Photo- 
shop, as well as some troubleshooting tips, visit http://helpx.adobe 

.com/photoshop/kb/photoshop-cs6-gpu-faq1.html.

COMPUTER INPUTS
When working in Photoshop, you’ll often need to attach different pe-
ripherals to your machine, such as a Wacom Intuos tablet, card read-
ers, and external hard drives. So you want to make sure you have 
plenty of fast ports available. On the USB side, make sure all of your 
ports are USB 3, and that they are plentiful. To run an external monitor, 
you should have one or two HDMI ports. Some laptops incorporate a 
DisplayPort or Mini DisplayPort. HDMI and DisplayPort are options to 
connect to bigger external monitors, which is a big plus.

THE COMPUTER DISPLAY
If there are places where you compromise on building a computer, 
the display should not be one of them. When you look at your imag-
es, you want to see them reproduced faithfully in terms of color. To 
do this, invest in a monitor that has a wide color gamut, has minimal 
(if no) shifting of color when looked at from different angles, has a 
high contrast ratio, and has a good amount of connectivity options 
to attach all of your devices. Recent advances in monitor technology 
pack a high amount of pixels per inch (ppi) on the screen, offering 
extremely sharp detail. You’ll hear these referred to as a Retina dis-
play on the Mac, as well as a High-DPI display. Anything more than 
a pixel density of 220 ppi will be considered extremely detailed and 
very desirable. 
 I was impressed with the display options on three of my laptops: 
the Toshiba Satellite P50T, the Razer Blade 14", and the 15" MacBook 
Pro with Retina display. The Razer Blade 14" uses an IGZO (indium 
gallium zinc oxide, a technology that gives you sharp images and is 
power friendly) monitor that has a high contrast ratio, wide viewing 
angles, and great color accuracy. The pixel density on this 14" moni-
tor is a stunning 262 ppi. The Toshiba Satellite P50T is one of the first 
laptops out there with a 4K screen and is Technicolor Color Certified. 
The calibration process that they’ve used is the same that’s used in 
motion pictures, so the color accuracy has been impressive. Its pixel 
density? A whopping 282 ppi. The MacBook Pro with Retina display 
uses a different technology for its screens (in-plane switching, or 
IPS), and produces great blacks and great color, and packs a pixel 
density of 220 ppi.

While I love the color on the laptops, I rely on larger external mon-
itors so I can get right into my work. At the office, I was asked to 
review some Samsung monitors from their 850 Series, as well as 
their newly announced S32D850T monitor. This 32" display is four 
times the resolution of a standard HD monitor, with a resolution of 
2560x1440—known as Wide Quad High Definition (WQHD). The 
monitor has a great viewing angle, great color accuracy, and gives 
me an incredible amount of real estate to work on with my images 
in Photoshop. I loved the monitor so much, I bought it and replaced 
the Apple Display that I had in the office. There’s nothing wrong with 
the Apple Display—it has great color—I just think that the color is as 
good, if not a tinge better. It offers four USB 3 ports, something the 
Apple monitor doesn’t, and is $300 less. 
 While I love that monitor, their U32D970Q - 32" 970 Series UHD 
Professional LED Monitor is jaw dropping. With a resolution of 
3840x2160, this monitor is four times the resolution of standard 
1920x1080 FHD monitors. It not only offers 100% sRGB color com-
pliance, but also 99.5% Adobe RGB, as well as 11 color space cali-
bration options. It took me a little while to get used to seeing things 
at that resolution, but I quickly forgave it due to how faithful the 
images look onscreen. 
 Full disclosure: I only spent about a week working with this monitor 
and had to send it back to them. That hurt. A lot. With a price tag of 
$1,999, it’s not for the casual user. I will get that monitor—one day. 

There you have it, a somewhat untechnical, anecdotal review of the 
things I consider when choosing a Photoshop machine. If you want 
to see more information on the machines and displays mentioned in 
this article, check out the links below. And if you’re a KelbyOne mem-
ber, don’t forget to check out http://kelbyone.com/discounts be-
cause we often have great discounts on hardware and computers. 
If you have any questions, please feel free to find me on twitter at 
http://twitter.com/aboutrc. ■

Toshiba Satellite P50T

Razer Blade 14"

15" MacBook Pro with Retina display
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•  4th Generation Intel Core i7 Processors:  

www.intel.com/content/www/us/en/processors/core/core-i7-processor.html

•  MacBook Pro with Retina display: www.apple.com/macbook-pro

•  Razer Blade: www.razerzone.com/gaming-systems/razer-blade

•  Samsung 850 Series:  
www.samsung.com/us/search/espsearch.us?keyword=850+series

•  Samsung U32D970Q - 32" 970 Series UHD Professional LED Monitor:  
www.samsung.com/us/computer/monitors/LU32D97KQSR/ZA

•  Samsung S32D850T - Samsung WQHD 32" LED Monitor:  
www.samsung.com/us/computer/monitors/LS32D85KTSR/ZA

•  Toshiba Satellite P50T Ultra HD 4K: www.toshiba.com/us/p50t

“Samsung's U32D970Q - 32" 970 Series 
UHD Professional LED Monitor is jaw 

dropping. With a resolution of 3840x2160, 
this monitor is four times the resolution of 

standard 1920x1080 FHD monitors.”
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http://helpx.adobe.com/photoshop/kb/photoshop-cs6-gpu-faq1.html
photoshop-cs6-gpu-faq1.html
http://kelbyone.com/discounts
http://twitter.com/aboutrc
www.intel.com/content/www/us/en/processors/core/core-i7-processor.html
www.apple.com/macbook-pro
www.razerzone.com/gaming-systems/razer-blade
www.samsung.com/us/search/espsearch.us?keyword=850+series
www.samsung.com/us/computer/monitors/LU32D97KQSR/ZA
www.samsung.com/us/computer/monitors/LS32D85KTSR/ZA
www.toshiba.com/us/p50t
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Step One: This technique works best if your subject is on a white 

or light-colored background, so photographers could shoot 

with this technique in mind. Open a photo and duplicate the 

image layer by pressing Command-J (PC: Ctrl-J). If your image 

consists of multiple layers (as in this example), create a stamped 

copy by activating the topmost layer and pressing Shift-Option- 

Command-E (PC: Shift-Alt-Ctrl-E). Make sure the resulting new 

layer, which you might double-click and rename “details,” is 

positioned at the top of your Layers panel.

Step Two: Choose Layer>New Adjustment Layer>Threshold 

(or click the half-black, half-white circle at the bottom of the 

Layers panel and choose Threshold). Either way, Photoshop 

adds the layer and turns your image’s highlights white and the 

shadows black. To increase the volume of highlights, drag the 

Properties panel’s Threshold slider leftward; to increase shad-

ows, drag rightward. Your goal is to achieve a nice level of 

detail while ensuring viewers can still tell what it’s a photo of. If 

some details disappear due to a lack of shadows, don’t panic; 

you’ll fix them momentarily.

Step Three: In the Layers panel, activate the details layer you 

created in Step One and, in the Toolbox, activate the Burn tool 

(nested under the Dodge tool [O]). In the Options Bar, set the 

Range drop-down menu to Shadows and the Exposure to 50%. 

Turn off Protect Tones. 

Step One

Step Two

Step Three

Step Seven

Step Five

Step Four

LESA SNIDER

A Threshold adjustment layer converts your image into an extremely high-contrast black-and-white image, all 
without harming your original. By pairing the end result with a bright and textured background, you can create a 
striking yet versatile silhouette effect that turns an ordinary image into a unique piece of art. 

Beginners' Workshop
 extreme contrast

Step Four: Mouse over to your image and brush across any 

areas that need darkening, like this lady’s hat; keep painting until 

the details reappear. With a Threshold adjustment layer already 

at the top of your layer stack, the darkening is immediately vis-

ible. If an area becomes too dark, switch to the Dodge tool and 

paint across those areas to lighten them.

Tip: If the silhouette looks too sharp, soften it with a blur filter. 

Shift-click to activate both the detail and Threshold adjustment 

layers and, from the Layers panel flyout menu, choose Convert to 

Smart Object. Choose Filter>Blur>Gaussian Blur. Enter a Radius 

value of 0.5 to 2 pixels (use a lower number for smaller images 

and a higher number for bigger ones), and click OK. Note that 

we didn’t blur the image in our example.

Step Five: With the top layer active in the Layers panel, click the 

half-black, half-white circle at the bottom of the Layers panel and 

choose Solid Color. In the resulting Color Picker, pick a range of 

colors from the vertical bar and click within the large square at 

the left to tell Photoshop how light or how dark the color should 

be. Click OK and Photoshop adds the new layer to the top of 

your layer stack. Tip: To change the Color Fill layer’s color later 

on, double-click its thumbnail to reopen the Color Picker.

Step Six: In the Layers panel, 

change the Color Fill layer’s 

blend mode to Darken to make 

the white background disap-

pear. (Blend modes in this sec-

tion of the drop-down menu 

tell Photoshop to look at the 

colors in your layers and keep 

the darkest ones.)

Step Seven: Choose File>Place (Embedded or Linked) and 

locate an image to use for texture (say, blurry snowflakes). Click 

Place and, if necessary, Shift-drag any resulting corner handle to 

resize the image, or drag within the bounding box to reposition 

it. Press Enter.
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Step Eight: Change the texture 

layer’s blend mode to Overlay 

and then rejoice at your creativ-

ity. Here’s the finished product, 

along with the Layers panel.

Colorized Shape Cutout
The exact same technique can also be used to create a nifty still-

life cutout.

Step One: Follow Steps One through Four above and then  

activate the Magic Wand tool (nested under the Quick Selection 

tool [W] in the Toolbox). Mouse over to your image (pine cones, 

in our example) and click a black area to select it. Next, choose 

Select>Similar and Photoshop selects the remaining black areas. 

Step Two: Add a new Solid Color fill 

layer as described in Step Five above, 

though this time pick red. Click OK to 

close the Color Picker. (Remember, 

you can change this color later by 

double-clicking the Color Fill layer’s  

thumbnail.) As a finishing touch, 

click the ƒx icon at the bottom of 

the Layers panel and choose Inner 

Shadow. In the resulting Layer Style 

dialog, adjust the settings if you’d 

like and then click OK. Here’s the final Layers panel and result.

As you can see, the effect is versatile and eye-catching. Be sure to 

choose File>Save As, and pick Photoshop from the Format drop-

down menu to preserve your layers for future editing. Until next 

time, may the creative force be with you all. ■

Step Eight

Step One

Step Two

©
M

el
ih

a
 G

oj
ak

/F
ot

ol
ia

http://www.adorama.com


Layout Design: Taffy Clifford
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P H O T O G R A P H Y  S E C R E T S  › ›

H  liday Photos

’Twas the night before 
Christmas when all 

through the house, all 
the family was stir-

ring, even the mouse. 
While the kids are pre-
paring for the festive 

next day, your lighting 
practice will cause St. 

Nick to say, “Merry 
Christmas to all, and  

to all a good light!”

Step One: Start with the Room
Choose the room you want to use for your Christmas photos and start 

scouting out how you want to shoot them. Think about angles, back-

grounds, and the space you have. Most of us want to show off the 

tree and any leg lamp that we may have won as a major prize. This is 

where a lot of folks will make the mistake of thinking that standing 

closer to the tree is going to look best. Truthfully, if your subjects stand 

next to the tree, they’ll have to fight with the tree for attention. Our 

eyes get easily distracted, and the busy tree is a tempting target. This is 

supposed to be a family portrait, not a tree portrait, so avoid that temp-

tation, and move away from the tree a bit so it will be a little blurry in 

the background (more about that later). 

Typical setting for Christmas photos

Too close to tree

By Pete Collins



› 
› 

k
e

l
b

y
o

n
e

.c
o

m

077

› 
› 

p
h

o
t

o
s

h
o

p
 u

s
e

r
 ›

 d
e

c
e

m
b

e
r

 2
0

14

076

Step Two: Get Help
To make the most of your practice session, you’ll need help. If 

you’re like a lot of us, you’ve exhausted your family’s patience for 

helping you when it comes to photography. As you can see in the 

previous image, you’ll need to get creative and go to a craft store 

and buy a couple of mannequin heads to act as stand-ins for your 

family. For many of you, this will immediately cut down on the 

stress and help you focus on the task at hand instead of trying to 

wrangle kids or a bored spouse.

You could put the head on a light stand and add a shirt 

on a hanger, or you can just use a chair or anything that will 

hold the heads while you practice. Have fun and get fancy by 

adding a wig and some lines using paint or markers to give your 

camera something to focus on and help you determine if your 

image is sharp when you’re checking it on the screen of your 

camera at 100%.

Yes, you’ll have to explain to your family and neighbors 

what you’re doing and why you’ve given your new best friend 

a name, but by now they already know that you’re a little 

weird, and it may even get you out of spending time with your 

creepy uncle.

Step Four: Lighting Your Subject
The lights of the tree and any other artificial illumination around the 

room are beautiful and are most appreciated in a dim room. This is 

fine while hanging out with cousin Eddie, but not so good for your 

pictures, so you may want to try your hand at adding a flash to your 

photographic arsenal. There are a bunch of flashes out there and 

you may have a favorite brand with certain bells and whistles, but 

let’s keep this simple. Even the cheapest manual flash can be a great 

asset if you know how to use it. We’ll discuss adjusting the impact 

of the light in a minute, but first let’s talk about a couple of ways to 

use the flash.

Aiming the flash right at your subject from the top of your 

camera is better than nothing, but it will leave them looking a 

bit stark, like a deer in headlights. Pointing your flash up will turn 

your ceiling into a giant source of light that’s very soft and pleas-

ing, but it may leave some dark shadows, especially under the 

hair and chin. This is a usable technique that can produce many 

wonderful images. Another version of this technique is to bounce 

the flash off a wall—the light, not the actual flash, because that 

would be sad. If you try this method, a great tip I learned from 

wedding photographer Joe Buissink is to bounce the flash off the 

wall in the direction the noses are pointing. Try it and you’ll find 

that you can get some wonderful indirect light, but it takes prac-

tice to handle the changing scene as your family moves around.

One of the easiest and cheapest ways to create great light for 

a single subject or your whole family is to get a piece of white 

foamcore and figure out a way to mount it slightly above your 

camera flash at a 45° angle. Point the flash into the foamcore, 

and when it fires, the light will bounce off the board and turn it 

into a light source that’s large and soft but also low enough to 

help fill in the shadows of the chin and hair. Simple but effective.

Step Five: Adjusting the Ambient Light
Once you’ve figured out where the subject will stand and how to 

bounce the light, you now have to adjust the look of the light on the 

subject and the ambient light for the rest of the image. We’ll assume 

the flash is set for manual and will fire the same amount of light each 

time. For instance, you figure out that with an aperture of f/2.8, ISO 

of 400, and a shutter speed of 1/125 that your flash set at 1/4 power 

lights the subject really well, but the ambient light is too dark and 

doesn’t let you see the tree and decorations very well.

Instead of messing with the flash and changing the look of 

the subject, simply change your shutter speed because it affects 

the look of the ambient light. Look at these comparison images. 

With the shutter speed being the only thing that changes, notice 

how it changes the look of the rest of the image while the subject 

stays lit the same way. Most folks get in trouble when they try to 

change too many settings at once. When practicing, only change 

one thing and see how it affects the image.

“What  
mannequin, 
honey?”

Step Three: Figure out the  
Look You Want for Your Photos 
Moving your subject away from the tree will help the look of your 

images if you understand how using the lowest possible aperture 

setting will create a shallower depth of field, making the background 

blurry. Aperture, or f-stop, is the size of the opening that lets light in 

through the lens: the higher the number, the more area the camera 

captures in focus; the lower the number, the shallower the depth 

of field.

Take a look at the comparison below. Notice especially how 

the tree and lights look at the different settings. Most cameras 

will come with a lens that can go down to about f/5 or f/4.5, 

which helps cut down on the busy look of the tree and lamp 

better than a higher aperture setting such as f/14. Lenses with 

f-stop numbers such as f/2.8 or lower tend to be a lot more 

expensive, but allow you to really showcase the subject you’re 

focusing on by blurring the background even more. If buying 

one of these lenses isn’t in your budget and you can’t convince 

your spouse to let you get one for Christmas, you might want 

to look into renting one for the holidays to give your shots a 

more professional look.

f/14 f/5 f/2.8

1/30 1/60 1/125
Shutter speed: slower=more ambient light

Practice results: Ready for single portrait

Straight flash Ceiling bounce Foamcore  bounce

Foamcore bounce setup

Compare flash results—notice harsh vs. soft
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Groups=higher f-stop and more power

I have no friends!

Step Six: Putting It Together
Now you have your scene set thanks to your model/stand-in, and 

you’ve figured out the aperture and shutter speed, and you’ve set up 

your flash and know what power to use. But before you call in your 

family, there’s one more scenario to practice. More people means 

that the shallow depth of field you used on a single person may not 

work, and you may have to try a higher f-stop to make sure that all 

the eyes of your family are in focus.

This is why you bought a few mannequin heads and added 

the lines. Practice with multiple heads and figure out the best 

aperture for the group, and whether you’ll need to increase the 

power of the flash. Usually, it may be a couple of stops of the 

aperture and maybe one more stop of light. (A “stop” is a term 

used to mean the next point in the scale; for instance, on the 

flash, going from 1/2 power to 1/4 power is called a stop.)

Now all that’s left is to call your family in and use the same 

settings that you nailed down in practice to capture some great 

family photos. They won’t believe how fast you’re able to take 

their pictures and how great they look. You’ll become a hero in 

their eyes, or at least it will validate your photography weirdness 

and maybe convince them to let you get that new lens. 

Step Seven: One Is the Loneliest Number
This technique also works if you don’t want to let anyone see 

what crazy thing you’ve set up for this year’s holiday selfie. Set up 

the mannequin right where you want to stand, make it the same 

height as you, then get all the settings right. Now all it takes is set-

ting the self-timer and a little patience to get your head in the right 

spot, and voilà! Super-selfie!

Christmas, families, and chaos seem to all go hand in hand. Add to that mix trying to figure out how to use 
a flash while taking family portraits and it almost guarantees to leave you with a less-than-happy experience. 
A little investment on the front end, and not being ashamed of playing with mannequins, can lead to a new 
understanding of how photography and lighting work and ultimately have your family singing your praises. ■

http://www.topazlabs.com/mktg/psuser-lake.html
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›  ›  l i g h t r o o m  ›  ›

Under 
the 

Loupe
The ubiquitous and often underrated JPEG is an incredibly versatile 

file format in your Lightroom output arsenal. Knowing all the ways 

that Lightroom can create JPEG versions of your photos is useful 

for keeping your workflow efficient and flexible.

a jpeg for every occasion
B Y  R O B  S Y L V A N

As a file format, JPEGs often get a bad rap when compared to 

RAW photos, and even when put up against file formats like 

TIFF and PSD. I was in a camera store recently and I overheard 

a customer asking an employee if he should shoot RAW to get 

better images, to which the clerk replied that he should stick to 

shooting JPEG unless he knew how to process the RAW data 

better than the engineers who created his camera. I thought that 

was a fair point. RAW alone doesn’t make a photo better, it just 

gives you more data to work with and lets you work with that 

data at a less baked-in phase of the image-processing pipeline. 

Clearly this is no small thing, and once you become proficient 

with any of the RAW processing software available, you can 

potentially achieve better results than the in-camera JPEG. The 

relatively smaller file size and out-of-the-camera finished results 

of a JPEG can sometimes trump the potential benefits of RAW 

capture, and there may be times when that matters most to your 

capture workflow.

When it comes to output, it’s a whole different story, and 

this is where that wonderfully compressible and universally sup-

ported JPEG file stands head and shoulders above the rest in 

many applications. A JPEG is the perfect file format for sharing 

photos online, via our mobile devices, and even when send-

ing out for prints. Every image viewer worth its salt can display 

a JPEG image and every printer can print one. For this reason 

Lightroom provides a JPEG output option in each of the output-

focused modules, which includes Book, Slideshow, Print, and 

Web, as well as the Export dialog. 

export dialog
Creating JPEGs via export is probably the most common situa-

tion we encounter. If you need a high-quality image with a rela-

tively small file size that can be displayed in anything from a Web 

browser to an image-editing program, then JPEG is your go-to 

choice. Maybe you need to email photos to someone, upload a 

gallery to a photo-sharing site, burn a DVD for a client, or count-

less other purposes: JPEG usually just gets the job done efficiently 

and with ease. 

The key to choosing JPEG on export is the File Settings 

panel of the Export dialog (File>Export). It’s here that you 

choose JPEG via the Image Format drop-down menu, then set 

the Quality slider to your desired amount of compression. This 

compression is JPEG’s greatest strength and greatest weak-

ness. The higher the Quality setting, the lower the amount of 

compression applied to the exported copies, which results in 

a larger file size (in bytes) with little or no compression arti-

facts. The lower the Quality setting, the higher the amount 

of compression applied to the exported copies, which results 

in a smaller file size with greater potential for visible com-

pression artifacts. Your job is to find the sweet spot on the 

Quality slider that matches the purpose for your export in the 

first place. 

As a rule, the Quality slider set in the neighborhood of 

80–90 will produce a reasonable amount of file compression 

(smaller file size) with little or no visible compression artifacts, 

and is a good choice when image appearance matters more 

than file size. If file size matters more than image appearance, 

you can try the Quality slider in the 60–80 range and check 

your results in a program like Photoshop to decide if you can 

live with the results for your given purpose for exporting. 

If file size in bytes really matters and you still want high 

quality, then the other factor to consider is a photo’s pixel 

dimensions. The larger the pixel dimensions of an image, the 

more pixels it contains, and hence the more data there is in 

the photo. For example, if during export (using the Image 

Sizing panel) I resize a photo that’s 6000x4000 pixels to 

3000x2000 pixels, I can keep the Quality slider at 80 and 

create a JPEG copy with a smaller file size in bytes than if  

I didn’t resize and set the Quality slider to 60. Using the Quality  

slider in conjunction with resizing the photo to the exact pixel 

dimensions you need (and no larger) is the most powerful way 

to reduce file size in bytes. Modern DSLRs produce photos  

with such large pixel dimensions you can usually get away 

with resizing exported copies smaller for most purposes. In 

the end, your reasons for exporting will drive the settings 

you make.

Note: The Limit File Size To option in the File Settings panel 

only uses increasing amounts of compression to attain the 

configured file size in kilobytes, and as a result may be unable 

to achieve the desired file size unless you also resize the pixel 
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dimensions smaller, too. This option is probably best reserved 

only for instances where you’re already resizing photos to very 

small pixel dimensions and you don’t really care about the 

amount of JPEG compression being applied. 

book module
The most common output of the Book module is uploading the 

finished book to Blurb to have it printed, but if needed you can 

also export the pages of your book as individual JPEG files, too. 

After you’ve created your Blurb book and clicked the Create 

Saved Book button to preserve your settings in a special col-

lection, click the Book drop-down menu in the Book Settings 

panel and choose JPEG. You’ll see that the Book Settings panel 

has the same JPEG-related output controls for Quality, Color Pro-

file, output Sharpening, and File Resolution as the Export dialog. 

The settings you choose will be determined by your purpose for 

creating the JPEGs. 

Click the Export Book to JPEG button at the bottom of the 

right-side panels to open the Save dialog. Click the Save but-

ton to start the process of saving out the JPEG files. The front 

and back cover will be saved as a single image, as will each 

individual page layout. Two-page spreads will be saved as a 

single image.

slideshow module
The Slideshow module isn’t sophisticated, but to its credit it is 

easy to use for creating layouts of your photos for presentations. 

If you need slide show features that Lightroom lacks (different 

fade options, multiple music tracks, per-slide timing, etc.), then 

you might consider simply creating the layouts in Lightroom and 

then exporting the slides as individual JPEG images that can be 

imported into a more robust slide show program. 

Once you’ve created your slide layouts, go to Slides how> 

Export JPEG Slideshow to open the Export Slideshow to JPEGs 

dialog. Here you can choose the pixel dimensions of the individ-

ual slides and set the Quality slider to determine how much JPEG 

compression is applied to each image. Typically, in this scenario 

you’re less worried about file size and more worried about how 

the image looks. Click the Export button to complete the process. 

print module
Creating JPEGs from the Print Job panel in the Print module 

generally has one specific purpose, which is when you want 

to save out a finished print layout as a single JPEG image to 

upload to an online print service. I stress the phrase “print lay-

out” because if you just want to output a bunch of borderless 

5x7s (or any other print size), then it’s a lot faster to simply use 

the Export dialog (after cropping the selected photos to the 

proper aspect ratio) to save out the JPEGs at the proper size for 

printing. A print layout is when you have multiple photos on 

one canvas or a single photo with a border, or anything that 

goes beyond the simple borderless single image print. 

To create a JPEG from the Print module you need to set the 

Print To drop-down menu in the Print Job panel to JPEG File. 

You can then check the Custom File Dimensions box and enter 

the size of the print you want to make (this way you are no lon-

ger limited to only sizes supported by your printer driver). 
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entire Web gallery (webpages, JPEG images, and associated 

code that makes it work) to a location of your choosing for 

easy upload to your website via FTP, if you’re unable to upload 

directly from the Web module itself using the Upload button. 

The key setting that relates to JPEG image quality in a Web 

gallery is the Quality slider in the Output Settings panel. This 

works the same way as it does in the Export dialog. ■

With your canvas set to the desired size, you can create 

your print layout to suit your needs, and when you’re ready 

for output you’ll find the same key settings as are available in 

the Export dialog, namely the Quality slider, Print Sharpening, 

and Color Management. The same general rule applies for the 

JPEG Quality slider here as in the Export dialog. Print Sharpen-

ing is entirely optional, but if you use it, make sure you choose 

the correct Media Type for the paper you’ve selected. If you’re 

unsure of the correct color Profile for where you’re sending 

your photos for printing, then be sure to ask the people mak-

ing the prints. Usually, sRGB is the safest option, but asking is 

better. Click the Print to File button at the bottom to save each 

page of the layout as a separate JPEG file.

web module
As far as the Web module goes, unless you’re creating a 

Flash gallery, the only option is an HTML gallery where all the 

images in the gallery are JPEGs by default. There isn’t any way 

to export only the JPEG images from a Web gallery (that would 

be a job for the Export dialog), but the Export button found at 

the bottom of the right-side panels allows you to export the 

http://www.fjwestcott.com/power
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As a retouching tool, you can do a surprising 

amount of work in Lightroom. Skin smooth-

ing, blemish removal, and even contouring can 

be done easily, all nondestructively. When it 

comes to any kind of reshaping of the face, we 

need to go to an external application. Of course 

we could look to Photoshop, but there are more 

automated routes via dedicated retouching 

programs. One of those is PortraitPro 12 from 

Anthropics Technology. 

portraitpro 12Maximum 
Workflow 

B Y  S E A N  M c C O R M A C K

Each of the currently available retouching plug-ins has wildly dif-

fering feature sets. PortraitPro is based on automatic correction 

from identified facial features, mixed with an expansive set of 

manual controls to refine that correction. These refinements can 

be saved as presets for later use. The program comes in three 

versions: Standard, Studio, and Studio Max. For Lightroom use, 

you need the Studio or Studio Max versions. There’s a trial avail-

able, with the restriction that you can’t save and the word “Trial” 

shows on the photo. Let’s get started.

step one: After installing PortraitPro, we need to set it up as 

an external editor. Choose Lightroom (PC: Edit)>Preferences and 

click on the External Editing tab. In the Additional External Editor 

section, click Choose. Browse to where PortraitPro was installed 

(usually in the Applications on a Mac, or Program Files on a PC) 

and click Choose. 

step two: Set the File Format to TIFF for the best results. 

Set the other options to your taste. Click the Preset drop-down 

menu and select Save Current Settings as New Preset. Name it 

PortraitPro Studio and click Create. 

step three: Select the photo you’d like to edit or use the 

download file provided. To open PortraitPro, go to Photo>Edit 

in and select PortraitPro Studio. In the dialog that appears, click 

the Edit a Copy with Lightroom Adjustments radio button, then 

click Edit. The first thing PortraitPro will do is find the faces in your 

photo. It presents you with a dialog so you can assign the gender 

and age (adult or child). If you’re working with the download, click 

Female to begin. Note: If you want to have PortraitPro operate as 

a true plug-in, go to PortraitPro (PC: Edit)>Preferences, check Auto 

Plug-in Mode at the bottom of the Settings dialog, and click OK.

[KelbyOne members may download the file used in this tuto-

rial at http://kelbyone.com/magazine/issue/december-2014. 

All files are for personal use only.] 

step four: PortraitPro will now make its automatic correc-

tions based on the default Female Standard preset in the Presets 

panel. On the left is the original face, and a purple face outline 

that needs to be matched to the contours of the face (visible as 

you hover over the face). On the right is the corrected version 

based on default settings.

step five: Use the yellow control points on the purple lines 

to match the contour of the face for more exact control on the 

retouching. The default 

corrections are quite 

impressive for simply 

opening a file and se-

lecting where the facial 

structure is. From here 

you can opt to switch 

from the before and af-

ter view to just the after 

view. Click the Flip to 

Before button at the top 

right to see the before 

view, and release the 

mouse button to return 

to the after view.

http://kelbyone.com/magazine/issue/december-2014
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Tip: While we’re talking about views, the Enhance Photo 

panel is docked by default, but can be a floating window by 

going to View and unchecking Dock Controls Panel. The top of 

the panel has a navigator view and controls for Zoom levels with 

a preview of the zoom location.

step six: Below the navigator is the Presets panel, which we’ll 

come back to. Below the Presets are the Portrait Improving Slid-

ers, which are manual controls for the retouching. A quick way to 

decide what areas need changing is to turn off each set of con-

trols by clicking the green button. By turning off the Skin Lighting, 

Eye, and Picture Controls, the photo looks more natural to me. 

This would make a great preset to begin the retouching. The eyes 

do need help, though, so turn it back on and let’s get to work. 

step seven: Click on 

the disclosure triangle to 

the left of Eye Controls to 

reveal the individual slid-

ers. The Red Eye Removal 

checkbox is at the top, and 

below is the Master Fade 

slider, which allows pro-

portional control over all 

the currently applied slid-

ers. Using the Eye Controls 

is straightforward, as each 

section is well-labeled. It’s 

vital that the purple outlines match the relevant areas of the 

eye, so the pupil tools work only on the pupil, for example. If 

you want even more control, click the disclosure triangle for 

each slider to gain control over the left and right eye separately. 

This level of detail is what makes PortraitPro so useful. 

step eight: Go down through the sliders and change to 

taste. Check the minimum and maximum settings to get a feel 

for the range of looks, and then hone in on what pleases you. 

Remember to switch between 1:1 and Fit in the navigator so you 

can see how your settings look on the whole face. You can see 

my settings here. 

Note: If you’re missing catchlights, the Add Reflection drop-

down menu can bring life back to the eyes. Choose a type of 

light from the list and use the Nudge Reflections controls to get 

an exact position in the eyes.

step nine: With the eyes fixed, let’s check the Skin Smooth-

ing Controls. The default settings look good, but could benefit 

from a tweak to remove more spots. At the bottom of the panel 

is the Spot Removal drop-down menu.

The Contrast slider changes the size of the light. A lower set-

ting emulates a larger, softer light source, while a higher setting 

produces a smaller, harder source. Modeling controls the focus 

of the light: a higher value adds much more shape to the face. 

Fix Lighting flattens the light. The remaining sliders add shadows 

as they’re named. Smokey Eyes adds an evening makeup look to 

the eyes, while Pout adds a shadow under the lips. As this photo 

was already lit, we’ll turn off the Skin Lighting Controls again.

step twelve: Face sculpting is one thing that can’t be done 

in Lightroom. The default settings in the Face Sculpt Controls 

look good, but like everything in PortraitPro, they’re extensively 

tweakable. The key elements here are the overall face shape and 

the eyes. Most people (women especially) will benefit from hav-

ing wider eyes. Use the Eye Widening slider for this. The Eyes 

section allows you to reshape eyes separately, as well as fix Cross 

Eyed features. Eyebrows can also be reshaped. 

The nose, mouth, and lips can also be reshaped here. The 

neck can be extended for a more graceful look. Face sculpting is 

one area where the subject will probably have something to say 

because, ultimately, you’re changing how she looks. 

step thirteen: By now, I’m sure you have the hang of using 

the plug-in. It’s so straightforward to use. Let’s briefly look at the 

remaining panels. The Mouth & Nose Controls panel is for teeth 

whitening or cleaning (these controls only appear if there are teeth 

The default setting is quite low, so even changing to a Low 

or Medium Sensitivity helps. There are some large spots that are 

being missed even with this, so it’s time to use the Touch Up 

Brush. Click the Touch Up Brush button above the photo and 

paint on the spots to remove them. If the undereye area is a little 

dark, the brush can help there. 

step ten: If you find areas of the skin that aren’t affected, 

click the View/Edit Skin Area button. The skin area will be cov-

ered in a purple mask. The Extend and Cut Back buttons allow 

you to change the mask. For this image, I extended the mask to 

include the shoulders. Click OK when you’re done setting the 

skin area. This control is available in the skin-related panels. 

step eleven: One of the new features in PortraitPro 12 is 

Skin Lighting. We’ve had this turned off so far, but it’s time to 

see what it can do. Upon opening the Skin Lighting Controls, 

we’re presented with a mesh face with a circle on it. This circle is 

the light source and dragging it around adds light and shadow to 

the face, creating a new source that wasn’t in the original image. 

I confess to being impressed with this, and while this image is 

already lit, I can certainly see uses for it in shots with flatter light.
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visible in the image), lip coloring, contrast, and darkness along 

with sharpening the mouth and teeth. Hair Controls allow you to 

recolor the hair via a drop-down menu of hair photos, along with 

adding Shine and Vibrance. You also have the ability to Lighten or 

Redden the hair. Similar to the skin-related panels, there’s a View/

Edit Hair Area button to allow editing of the hair mask.

step fourteen: Skin Coloring Controls let you color-correct 

the skin, as well as adjust the Temperature and Tint. There’s 

a separate slider to control the color outside the face, as well. 

There’s also a Cheek Coloring control with separate hue and 

saturation controls for each cheek. Finally, you can change the 

Tan color and strength on the skin. 

step fifteen: The final panel is Picture Controls. This panel 

gives control of the overall look of the photo. It’s reminiscent of 

the Basic panel in Lightroom with Temperature, Tint, Exposure, 

Brightness, Smart Contrast, Vibrance (including Saturation), and 

Tone Curve. The Tone Curve contains controls similar to that of 

the parametric tone curve in Lightroom. I think the Basic panel in 

Lightroom gives more control, so you don’t have to use this panel. 

step sixteen: If you like the overall look and want to use 

it again without all the effort, go to the Presets panel and click 

Save Preset. This brings up the Save Preset dialog where you can 

save settings as a preset, set it as the default preset, and choose 

which panel settings get saved in the preset. You can manage 

presets from there, too. To save the image and send it back to 

Lightroom, click the Save button (or the Return From Plugin but-

ton if you’re running it as a plug-in) at the top left. The retouched 

image will appear in Lightroom with the original. 

The photo used here is of a 

model, but the controls work 

exactly the same for everyone. 

Here’s how the preset we cre-

ated looks on a more mature 

(and awesome) lady. It’s a little 

too much, but still a quick start 

for a happy client. 

A word of warning: It’s easy to overdo it, and with retouch-

ing, less is more. The Studio Max version of PortraitPro 

provides full batch processing, so wedding photographers 

especially can take advantage of the time savings involved in 

fixing large quantities. ■ 

http://www.epson.com/cgi-bin/Store/jsp/Landing/finish-strong_ad.do?ref=van_ad_fsmain
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Original folder structure is duplicated  
in the Export as Catalog process

selected and choose File>Export as Catalog. You can also Right-
click on the collection and choose Export this Collection as a 
Catalog. In the Export as Catalog dialog, make sure to choose 
Export Negative Files (this will make a copy of the files). 

When the process is done, find the .lrcat file for this new test 
catalog and double-click it to open it into Lightroom. The nice 
thing about creating a test catalog this way is that any collec-
tions that the images were already a part of in your main catalog 
will be duplicated in the test catalog. Existing metadata such 
as ratings, flags, and keywords are also carried over. Even the 
nested folder structure of where the original images were stored 
is re-created inside the test catalog folder.

lightroom catalog forensics
I have a network of photography and digital workflow consulting 
clients that I work with, both in person and online, and recently 
I’ve run into some interesting catalog issues that required some 
creative solutions to resolve them. One of the things that helped 
me solve these problems was knowing what to expect in terms 
of how a certain operation would affect the overall catalog.  
A key component behind the scenes was a test catalog. 

why you should make a test catalog
Test catalogs aren’t just for consultants or those who teach and 
write about Lightroom. I strongly recommend that everyone 
maintain a test catalog in addition to his or her main image 
catalog. A test catalog (some like to call it a “stunt catalog”) 
can be used to test various catalog operations without worrying 
that you might cause a problem in your primary catalog, or to 
the images it references.

setting up a test catalog  
folder structure
For a test catalog to be useful, it should contain a fair number 
of images. It doesn’t need to have thousands of images (though 
some people do have test catalogs that large), but you should 
consider having at least several hundred shots in it. These should 
be a variety of file formats that you regularly use: RAW files, 
DNGs, JPEGs, TIFFs, and PSDs. Create a special file directory for 
your test catalog containing a nested folder structure that’s simi-
lar to what you have in your main image archive, and copy the 
files into this test catalog folder structure. For this operation you 
can copy the files using the Mac Finder or the Windows Explorer. 
For example, I made an upper-level folder called “Test Catalog 
Files” (to make it clear that’s what they’re for), and then inside 
that I created several folders for different years, and within each 
year folder I added several folders of images.

creating a new catalog
Once you have the folder structure set up and have copied a 
range of different file types into it, open Lightroom and choose 
File>New Catalog. Target the folder you already created for your 
test catalog files and give it a name that makes it clear what it 
is. Then, import the images you already copied to that folder. 

set up a test catalog using export  
as catalog
Another way to set up a test catalog is to create a collection in 
your main catalog and add lots of images to it. Make sure to 
use a range of different file formats. Once you’ve added a few 
hundred images to the collection, make sure the collection is 

what to do with a test catalog
Once you have the test catalog up and running, you might 
wonder how you should use it. If you’ve ever wondered how 
to do a certain catalog operation, but weren’t sure about doing 
it to your main catalog, that’s a perfect thing to try out with 
the test catalog. For instance, if you’ve never done an Import 
from Another Catalog process, you can use this to test the steps 
needed to merge two catalogs together. This is a procedure that 
I use all the time for integrating images from a trip that I’ve 
recently returned from. 

The test catalog is your proving ground for running through 
new catalog management procedures that you may not be 
totally sure about. By first experimenting with the test catalog, 
you’ll know what to expect when you need to do something 
similar with your real Lightroom catalog. ■

SEÁN DUGGAN

ADOBE PHOTOSHOP   Lightroom Section ›  ›

& TipsTricks

http://spiderholster.com
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By Kevin Ames

Color
Control, Exposure, and Creativity

The photography session is finished and the camera, props, and lights are all put away. The work is 
complete. Not really. Postproduction includes refining the exposure, color correction, and creativity—
all in Adobe Camera Raw.

Once the shoot is complete and the RAW files (you are shooting RAW, right?) have been downloaded 
and backed up, the rest of the work begins in earnest. There’s the necessary color corrections and 
exposure refinements, then the fun begins: exploring the depths of photographic goodness in those 
versatile RAW files.

D Y N A M I C  R A N G E  › ›

The best place to start is with neutral color. Elim-

inating highlight color cast is a snap in both 

Camera Raw and Lightroom. The key is having a 

colorimetrically neutral target in the photograph. 

The standard tool is the 24-patch ColorChecker 

brand target from X-Rite. Model Jennie Carroll 

is holding the ColorChecker Passport that I carry 

everywhere my camera goes.

The white patch (#1 sampler) reads R:243, 

G:244, B:240; the middle gray (#2 sampler) is 

R:138, G:140, B:132; and the black (#3 sam-

pler) shows R:37, G:37, B:36. In each instance, 

the red and green are brighter than the blue. 

The color cast is slightly yellow.

Correcting the highlights couldn’t be easier. 

In Camera Raw, tap the I key for the White 

Balance tool, or press W for the same tool in 

Lightroom. Click on the patch just below the 

white one on the ColorChecker. That’s it.

After correction, the numbers are much 

closer to neutral. Sampler #1 is now R:243, 

G:243, B:242; sampler #2 now reads R:138, 

G:137, B:138; and #3 shows R:38, G:38, 

B:39. The White Balance tool was clicked on 

the patch immediately below the #1 sampler 

to neutralize the photograph. Their numbers 

(R:226, G:226, B:226) are the same, so that 

patch is completely neutral. A one-point differ-

ence on the other patches will be more than 

close enough for all but the most hypercritical 

color outputs. There are tools in Photoshop 

that can make the numbers match perfectly. 

The difference in the example is subtle and 

yet quite noticeable when they’re compared. 

Camera Raw 8.6 has before and after compar-

isons in the preview window. Press Q to cycle 

through the preview modes. 

COLOR FIRST

www.photoshopuser.com
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It’s important to maintain shadow detail when working in 

Camera Raw. As tempting as that Contrast or Blacks slider may 

be for creating drama, resist them at least until you print. It’s 

easy to increase contrast and deepen blacks in Photoshop. It’s 

impossible to get details in the shadows back once the file is 

converted to pixels. 

This example shows the ColorChecker Passport being held 

by our model Hope from Presence Models in Atlanta. The expo-

sure of her looks good. The histogram looks good. The numbers 

tell a different story. 

Look at the results for the two color samplers on the white 

patch (#1) and the black one (#2). Values of R:216, G:215, 

B:215 are considerably under the target of 242-ish (I say “ish” 

because these are guidelines, not absolutes). The values in #2 

(R:24, G:23, B:28) are so low there would be almost no shadow 

detail. What’s going on here?

Two things. First, the light is coming from Hope’s left. The inci-

dent meter measuring the exposure was aimed directly at it. The 

exposure on the camera, shown under the histogram, is f/8 at 

1/200, ISO 100. Second, the ColorChecker is pointed directly at 

the camera. It’s seeing less light than the meter did. It’s important 

that the ColorChecker is angled toward the light the same way 

the meter was and not at the camera. 

Tweaking the Exposure Slider
The last part of the exposure refinement is to get the numbers 

up to approximately 242 or 95.1%. This guarantees there will be 

detail in those important highlights, such as a bride’s wedding 

gown. I’ve moved the Exposure slider to +0.30, or an increase of 

a third of a stop.

The shadows benefit, too. They’re now in the 50s, giving 

lots of detail to the dark side. All that’s left is to apply the 

tweak to the rest of the photo shoot. I allow myself plus or 

minus a half-stop adjustment on exposure before changing 

the camera. Any more than that and I’m wasting the depth of 

data in my capture.

This is the fun part. There’s so much more data in a RAW capture 

than what shows on the monitor that the creative opportunities 

are seemingly endless. We’ll start with a silhouette of Vanessa 

who is standing in front of some sheer curtains. 

REFINING EXPOSURE

“Computers are 
great tools  
for getting  

technically correct 
exposures.” 

Light meters, particularly incident meters, provide a great start-

ing point for a correct exposure, one that accurately reveals the 

true tone of the subject. Making certain that the photograph is 

optimized for reproduction is part of the work in post. A lot of 

photographers refine exposure using the histogram. Others rely 

on their monitors (that are calibrated) and judge the result by eye. 

While that may work for some, the human eye, for all its sensitivity 

to amounts of light and color, is forever prejudiced by the human 

brain. The brain does auto exposure and color correction, saying 

to us, “That looks great! It must be the right color and exposure.” 

Unfortunately, no matter how skilled, the eye and brain combina-

tion have a really hard time getting exposure and color right. 

Correct Exposure by the Numbers
Computers are great tools for getting technically correct expo-

sures. These are done by comparing readings of known reflectivity 

patches against reproducible detail in the highlights and shadows. 

Generally speaking, highlight values with detail fall between 242 

and 248 in Photoshop and 95.1% to 95.5% in Lightroom. The 

shadow detail threshold is 25 for Photoshop and 7% in Lightroom. 

Readings below will very possibly be completely black. 

White or Just Light Gray?
The exposure, f/11 at 1/200, ISO 125, renders the background 

through the curtains as white. Or are they? A quick look at the 

numbers on the three color samplers shows that the background 

is evenly lit. The numbers also reveal that its brightness is well 

below the white, with a detail threshold of 242 to 248. Let’s look 

at how we can tweak the RAW capture. 

[KelbyOne members may download the file used in this 

tutorial at http://kelbyone.com/magazine/issue/decem-

ber-2014. All files are for personal use only.]

When Hope holds the ColorChecker at the source of light, the 
highlight numbers are now just below the lower highlight 
with detail threshold. Notice that Hope’s left side is the same 
brightness in both of the photos.

DIVING INTO RAW CAPTURES

Shadows with detail Middle gray Highlights with detail

www.photoshopuser.com
http://kelbyone.com/magazine/issue/december-2012
http://kelbyone.com/magazine/issue/december-2012
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ALL IMAGES BY KEVIN AMES

Step One: Making this photo into a true silhouette is done 

differently than you might think. First, drag the Highlights slider 

to +100 and Shadows to –100. The numbers show that you’re 

almost there. Next, bump up the Whites to +63 and drop the 

Blacks down to –59. Use the Color Sampler tool (S) to mouse 

over areas of the photo. The curtains are completely blown out 

at RGB:255, while Vanessa is completely black at RGB:0. The 

point to note here is that neither the Exposure nor Contrast 

slider is involved. 

The Highlights slider works on values from middle gray (PS: 

127, LR: 50.2%) to white (PS: 255, LR: 100%). The Shadows 

slider controls middle gray and goes down to black (PS: 0, LR: 

0%). The Whites and Blacks sliders work on the same ranges as 

Highlights and Shadows, respectively. 

Step Two: The floor and the curtains want to be closer to 

white, too. Use the Graduated Filter (G) in Camera Raw or (M) 

in Lightroom. Click-and-drag a Graduated Filter up from the 

bottom of the frame. Set Exposure to +4.00 and Shadows to 

+41. The floor is white and the curtains are a much lighter tone, 

but her feet are too bright. Camera Raw 8.6 has a Brush radio 

button at the top of the Graduated Filter tab. Click it and an 

Add to (+) and Subtract from (–) brush icon appears. Click the 

Subtract from brush, then paint away the excessive brightness 

using a 9-pixel brush with a Feather of 48 and Flow of 8. This 

will darken her feet to make them look like they’re lit by the 

light on the floor. When you’re done, press G to exit the Grad-

uated Filter (press M in Lightroom). 

Step Three: Color! The monochromatic version is good, but 

how about some color? Drag the Temperature slider all the way 

left to 2000 to make it blue. Set Clarity to 100 and Vibrance to 

13 and the sheers are now much more detailed. To lighten them, 

click the HSL / Grayscale tab (fourth icon). Click the Luminance 

tab then drag Blues to the right to about +40. 

This is quite a change from the original photograph. 

Experiment with other colors, starting with a warmer tem-

perature. Check out the Tint slider, too, and mix in the HSL / 

Grayscale panel. 

The new tools in Camera Raw make creative exploration of all 

of the data you’ve captured available to use as your imagination 

dreams. Go play! ■  

http://www.bhphotovideo.com
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Step One: To begin, download the sjv_LuminosityExperiment.psd 

file and open it in Photoshop. The gray bars are the same as the 

black-to-white gradient but they make it easier to compare some 

changes and find midpoints as you work with the file. The solid-

color bars are set to 100% brightness for each color, and the file 

is built in the RGB color space with 16-bit depth for simplicity. 

[KelbyOne members may download the files used in this tuto-

rial at http://kelbyone.com/magazine/issue/december-2014.  

All files are for personal use only.]

Note: I built the experiment file using gamma settings of 2.2 

for both RGB and gray. If you’re not familiar with these settings, 

read up on color profile management and monitor calibration. 

Using different settings will result in your experiment file looking 

a bit different, but don’t let that be the only reason to adjust 

your settings.

Before your proceed to Step Two, double-click the Edit 

in Quick Mask Mode icon (dotted circle in a square) near the 

bottom of the Toolbox. In the Quick Mask Options dialog that 

appears, make sure the Masked Areas radio button is selected, 

then click OK. Press Q to exit Quick Mask mode.

Step Two: Go to the Channels panel (Window>Channels). 

Command-click (PC: Ctrl-click) on the RGB channel to load the 

luminosity. You should see marching ants around the selected 

areas in the screen. The RGB channel is a composite that shows 

you what’s currently visible on the screen. When you load the 

luminosity, you’re using the current canvas view. That means you 

can change the luminosity by changing characteristics in your 

layer stack, such as Opacity, blend modes, and adjustment layers.

SCOTT VALENTINE
Photoshop Proving Ground 
 channel selections

Step Three: Click the 

Save Selection as Channel 

icon (circle in a square) at 

the bottom of the Chan-

nels panel. This creates an 

alpha channel and stores 

the selection for later 

use. More importantly, it 

lets you edit the selection 

as if it were a grayscale 

layer. While you can use 

many different tools on 

alpha channels, we’ll stick 

to working with selections and adjustments this time around. 

Double-click the Alpha 1 channel’s name to rename the channel 

“L1” for Light 1.

If it strikes you odd that the three color bars are different shades 

of gray in L1 than they are in their own channels, don’t worry; 

that’s the difference between brightness and luminosity. Note that 

if you want brightness of a color, use the color channels. If you 

want luminosity of your image, use the composite channel.

Working with Luminosity Channels
You can use the new luminosity channel L1 as a mask by either 

Command-clicking (PC: Ctrl-clicking) on the channel thumbnail, 

or by choosing Select>Load Selection. Once loaded as a selection, 

it will be automatically applied as a mask when you choose an 

adjustment layer or add a mask to an existing layer. You can also 

fill the selection on a mask or regular layer. Experiment with those 

techniques on your own.

Each command’s cursor mod

H O W  T O  › ›

The fun and useful part of all of this is refining your selec-

tions. With an active selection, you can add to, subtract from, 

or intersect with information on other channels. Let’s say you 

have Channel A and Channel B. Command-click (PC: Ctrl-click) 

on Channel A to load the gray values of Channel A into a selec-

tion, then:

•  Command-Option-click (PC: Ctrl-Alt-click) on Channel B  

to subtract B from A

•  Shift-Command-click (PC: Shift-Ctrl-click) on Channel B  

to add B to A

•  Shift-Command-Option-click (PC: Shift-Ctrl-Alt-click)  

on Channel B to intersect B and A

Each of these gives you different active selections, but you have to 

create a new channel or mask to see the results.

Build Luminosity Masks
To build luminosity masks for different values, say lights (L1), bright 

lights (L2), and specular lights (L3), you’ll use the Intersect com-

mand on the same layer. Intersect compares the current selection 

with the new selection and only keeps the overlap. When you 

intersect a selection with itself, such as by loading A and intersect-

ing A, you’re basically compressing the dynamic range of the selec-

tion, where 50% gray becomes 25%, but 100% stays 100%.

Step One: Use the Eyedropper tool (I) and the Info panel 

(Window>Info) to see that the center gray bar at the bottom 

in L1 is 50% gray. (Note: If you don’t see the HSB values in the 

Info panel, click on the panel’s flyout menu at the top right, and 

select Panel Options. In the Info Panel Options dialog, select 

HSB Color in the Mode drop-down menu in the Second Color 

Readout section, and click OK.) Load L1 as a selection, then 

Shift-Command-Option-click (PC: Shift-Ctrl-Alt-click) on L1 

again to intersect it with itself. Click the Save Selection as Chan-

nel icon and note that everything has shifted. All the grays are 

darker and the 50% midpoint has moved to the right. Name 

this new channel L2. Repeat the process for L3 by loading L2 

and intersecting it with itself. Note the shifts and that you’re 

zeroing in on the brightest highlights. Press Command-D (PC: 

Ctrl-D) to deselect.

Step Two: Build the darks by duplicating the L1 channel (click-

and-drag it onto the Create New Channel icon). Press Command-I  

(PC: Ctrl-I) to invert it, then name it D1 for Darks 1. Doing the 

same thing you did with lights will give you progressively darker 

shadow selections. 

Step Three: Easy, huh? Here’s where things get tricky. For 

midtones, use Calculations (Image>Calculations) with Blending 

set to Difference (see the dialog below for other settings), and 

click OK. Press Command-I (PC: Ctrl-I) to invert the result, and 

name it M1. Repeat the intersection technique to get narrower 

midtone masks. You must use Difference and not the Subtract 

command above because Difference uses absolute values. Try 

Gray bars showing shift from L1 to L2

One of the ways you can slice and dice your images for building masks is by taking advantage of the luminosity 
and brightness of the image. This issue, I want to share a few advanced tricks for working with channel selections. 
Using these techniques, you can build precise adjustment masks in short order for ultimate control over your photos. 
Reminder, for masks, white reveals and black conceals.

sjv_LuminosityExperiment.psd
http://kelbyone.com/magazine/issue/december-2014
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Before After

M1 before (top) and after  
inverting (bottom)

both and note that Dif-

ference gives you sym-

metry in the overlapping 

grayscale bars, with white 

on the edges and black in 

the middle.

If you’re really famil-

iar with color theory, you 

can use the color chan-

nels directly to make even 

more complex selections 

for color elements in your 

photo. Try loading the 

RGB luminosity then sub-

tracting the brightness of 

one of the color channels. 

Even better, select magenta by loading the Red channel and 

intersecting with Blue. How would you get yellow-orange? 

What about cyan?

I need to leave you with a few notes and caveats about explor-

ing this technique. First, channels can weigh down your document! 

The more channels you have, the larger the file size because they 

contain similar information to a regular pixel layer. Second, you 

can load selections and immediately create masks without saving 

as an alpha channel first. This is a great option if you know what 

you’re selecting and don’t need all the intermediate channels. 

Third, keep the Histogram panel open while you’re experimenting 

with alpha channels to see changes in your selections in real time. 

Finally, users who love luminosity masks build actions to help cre-

ate stacks of alpha channels for lights, darks, and midtones.

Tear into the Channels panel of the sjv_Chair.psd file to see how 

I’ve applied alpha channels to adjustments. Happy experiment-

ing and be sure to post your results and questions to the Photo-

shop Proving Ground page on Facebook (www.facebook.com/

psinsight). ■ 

sjv_Chair.psd
www.facebook.com/psinsight
www.facebook.com/psinsight
http://kelbyone.com/marketplace/books/
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We’ve been able to turn 360° panoramas into circular images for many years thanks to the Polar Coordinates 
filter. Here, I’ll show you how to do this the smart, reeditable way with smart objects and smart filters.

Beyond Photoshop
 smart circular panoramas 

SCOTT ONSTOTT

Step One

Step Five

Step Four

Step Three

Step Eleven

Step Nine

Step Eight

Step Six
Step One: Open a 360° panoramic image (you can download 

the one we’re using here from http://kel.by/1wNN4MT). Select 
the Rectangular Marquee tool (M) and choose Fixed Ratio from 
the Style drop-down menu in the Options Bar. Type 1 in the 
Width field and 1 in the Height field. Drag out a square marquee 
on the extreme left side of the panorama.

Step Two: Press V to select the Move tool and Command-R (PC: 
Ctrl-R) to toggle on the rulers if they’re not already displayed. 
Drag a vertical guide from the left ruler and place it along the 
right edge of the selected region. Press Command-D (PC: Ctrl-D) 
to deselect all.

Step Three: Choose Layer>New>Layer from Background. Type 
“Austria” as this layer’s name and click OK to close the New 
Layer dialog. Right-click the layer’s name in the Layers panel and 
choose Convert to Smart Object from the shortcut menu. Press 
Command-T (PC: Ctrl-T) to freely transform the smart object. 
Drag its right handle to the left until it snaps to the guide you 
drew previously. Click the Commit Transform icon (checkmark) 
in the Options Bar so that you now have a square image.

Step Four: Choose Image>Trim. Select the Transparent Pixels 
radio button in the Based On area and click OK. Choose Filter> 
Distort>Polar Coordinates. Choose the Rectangular to Polar radio 
button and click OK.

Step Five: Right-click either ruler and choose Percent from the 
shortcut menu. Drag a vertical guide out from the left ruler and 
drop it at 50% as measured along the top ruler. Drag a hori-
zontal guide down from the top ruler and drop it at 50% as 
measured by the left ruler. Select the Ellipse tool (nested under 
the Rectangle tool [U] in the Toolbox) and select Path from the 
Pick Tool Mode drop-down menu in the Options Bar. Position the 
cursor at the intersection of the two guides in the center of the 
image and, holding Shift-Option (PC: Shift-Alt), drag out a circle 
and drop it along the circumference of the polarized panorama 
to create a work path.

Step Six: Hold the Command (PC: Ctrl) key and click the Add 
Layer Mask icon (circle in a square) on the lower edge of the 
Layers panel. This converts the work path into a vector mask, hid-
ing the starburst effect streaming out from the center. Choose 
Layer>New Fill Layer>Solid Color. Type “Backdrop” as the name 
and click OK in the New Layer dialog. Select a dark blue similar to 
the color of the sky in the image and click OK to close the Color 
Picker. Choose Layer>Arrange>Send Backward.

Step Seven: Select layer Austria 
in the Layers panel. Choose Filter> 
Other>Offset, click OK, and observe 
that Offset appears as a smart fil-
ter in the Layers panel. Drag-and- 
drop this filter below Polar Coordi-
nates in the smart filter stack within  
this layer so that Offset gets evalu-
ated first.

Step Eight: Double-click the Offset smart filter to reopen the 
Offset dialog. Drag the Horizontal slider a short distance to the 
right, and click OK to see how it has rotated the image. Repeat 
this process until you iteratively rotate the peak to the bottom 
of the circular composition (this happens at +1240 pixels in this 
case). Hide the guides by pressing Command-; (PC: Ctrl-;).

Step Nine: Click the Add a Layer Style icon (ƒx) on the bottom 
of the Layers panel and choose Bevel & Emboss from the shortcut 
menu. In the Layer Style dialog, set Size to 250 px and Angle 
to 90°, and click OK. This style produces a shadow around the 
bottom of the circle, making the composition appear more like 
a crystal ball.

Step Ten: With this smart object and filter setup, in addition to 
creating crystal balls, you can also easily create planets. Double-
click the smart object’s layer thumbnail to open its document 
window. Press Command-T (PC: Ctrl-T) to freely transform the 
panorama. Type 180 in the Rotate field in the Options Bar and 
click the Commit icon. Close and save the PSB file by press-
ing Command-W and Enter. The composition has turned itself 
inside out. 

Step Eleven: Double-click the Offset smart filter to open its dia-
log. Drag the Horizontal slider a little to the left and click OK to 
see the rotation. Repeat this process until you iteratively rotate 
the peak to the top of the circular composition (this happens at 
–266 in this case).

In this article you have created a smart framework, allowing you 
to produce beautiful circular compositions from 360° panoramas. 
You can replace the sample panorama with your own simply by 
opening the smart object and placing your panorama inside (take 
care to match the sample’s aspect ratio for best results). ■
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Product Reviews

Professional RAW Converter
 Review by Erik Vlietinck

 Capture One Pro 8 

It was by no means a slow application, 

but version 8 of Capture One Pro has 

been updated with a new processing 

engine. I got my hands on a fresh copy 

and found several improvements that 

make it the choice of the professional, 

starting with its pristine, neutral dem-

osaicing algorithm.

Capture One Pro 8’s new process-

ing engine makes for an even faster 

processing speed than its predecessor, even on somewhat older 

machines like my three-year-old iMac. But speed isn’t everything: 

the Capture One engineers tried harder and improved a lot of 

Capture One’s already impressive functionality. 

Improvements that caught my eye include better image qual-

ity when using the High Dynamic Range (HDR) tool, which lets 

you restore detail in highlights and shadows without introducing 

noise. Another impressive improvement is much better image 

quality when working with high ISO images. I tested the new 

Luminance Noise Reduction with an image shot at ISO 3200 and 

compared the results with a DxO PRIME reduction. Much to my 

surprise, there was hardly any difference. The improved lumi-

nance noise-reduction algorithm is one of the main reasons why 

you’ll want to check out version 8.

The addition of a Natural Clarity method is good, but there’s 

only a subtle difference between that and the Neutral setting. 

Not so subtle, and absolutely a winner, is the expansion of the 

number of corrections, edits, and effects you can apply to local 

areas using the Layers feature. There are now three types of lay-

ers: adjustment (the one we know from previous versions), heal-

ing, and cloning. You can freely switch between the three. The 

two new layer types offer the same sort of functionality as the 

Clone Stamp and Healing Brush tools in Photoshop, but they 

seemed easier to use for someone who has never worked with 

these types of brushes before. You can also apply more local 

adjustments, including White Balance, HDR, Noise Reduction, 

and Purple Fringing.

Film Grain is new, too, but that’s the one feature I wasn’t so 

sure about. Capture One Pro 8 doesn’t try to emulate specific 

films (e.g., Kodak TRI-X 400), but only draws inspiration from 

them. Phase One argues that there are simply too many vari-

ables. For example, a film from the ’50s will look different than 

the same product in the ’70s. There are questions of how old it 

was before it was used, how it was developed, etc.; hence, the 

more generic approach of adding Cubic Grain, Smooth Grain, 

Silver Rich, and others. For a full film stock emulation, users 

should create a creative style and fiddle with the Black & White 

conversion sliders, the Curve panel, and Film Grain.

Finally, the digital asset management (DAM) part of Capture 

One Pro 8 is slowly maturing. You can now import your Apple 

Aperture Library straight into a Capture One catalog. Catalogs 

can have hierarchical keywords, catalog folders can be synchro-

nized, etc. Sessions, which are especially useful for tethered 

shooting, are still available and the import functionality has been 

differentiated between catalogs and sessions. Metadata editing 

has improved and metadata can be edited in the Filters panel.

For Capture One Pro 8, Phase One has expanded tethered 

functionality. Support for many cameras has been added— 

tethered support for select Sony cameras, for example—but 

obviously the most sophisticated support is still to be had with 

Phase One cameras. ■

Company: The Iconfactory  Price: $49.99 (Upgrade: $24.99)

Web: www.xscopeapp.com Rating: ◆ ◆ ◆ ◆ ◆

 Hot: Enables better design/compositing; beautiful, efficient interface

 Not: 

Graphic and Compositing Design Assistant
 Review by Erik Vlietinck

Compress JPEGs without Artifacts
 Review by Erik Vlietinck

 JPEGmini Pro

The Iconfactory and Artis Software developed the first version 

of xScope for the purpose of designing layouts and measuring 

or inspecting onscreen graphics. This simple tool had only Ruler, 

Guide, Frame, and Screen modules that worked across all applica-

tions. Now there’s xScope 4, which truly enables a fluid workflow. 

Sharing your work on Dribble is as easy as selecting the pre-

defined Dribble Uploads Screen size from the Preferences panel. 

Mirror lets you show Retina comps the easy way: Just drop a PSD 

file onto the xScope 4 Dock icon and the comp will be sent to the 

iOS device every time you save. 

Mirror also has the following new features: Templates auto-

matically generate views of an app icon or wallpaper for different 

scenarios in iOS. It comes with AirPlay Mirroring, meaning any 

file, clipboard, or Photoshop document can be displayed on Apple 

TV. To prevent updates to a Photoshop document you’re work-

ing on, it can be locked to the iOS display when you switch to a 

new PSD file. xScope saves mirroring mode across launches and 

automatically reconnects to Photoshop when it’s turned on so you 

can immediately pick up where you left off. In Mirroring mode, 

you can also display file contents and the image clipboard. xScope 

now also supports Acorn files.

Compressing an image, especially a JPEG, to its smallest possible 

size often introduces ugly artifacts. JPEGmini Pro seeks to avoid that.

JPEGmini Pro reduces the file size of JPEG photos while preserv-

ing the originals’ resolution and quality. It uses all of your process-

ing cores and can process images of up to 50 megapixels. JPEGmini 

Pro uses parameters that have been tuned to reduce the file size 

without affecting perceptual quality and is based on a proprietary 

compressing algorithm that doesn’t introduce quality loss. It’s a bit 

like JPEG 2000 or WebP, but one of the major benefits of JPEGmini 

is that it doesn’t require a whole new format that’s supported by 

few Web browsers, if any.

JPEGmini analyzes the input image using a quality detector that 

imitates the human visual system. Based on this analysis the app 

applies the maximum amount of compression that won’t cause 

visible artifacts at 100% magnification. Size reductions of 70–80% 

are achieved easily with JPEGs greater than 8 megapixels.

I tested JPEGmini Pro with three 40-megapixel Hasselblad files 

and a dozen 12-megapixel Sony Alpha files. This app is fast! The 

compression it achieved was equally impressive, and even a bit 

more than claimed with some of my photos. The visual charac-

Web designers will love the xScope 4 features, too. For instance, 

Text shows the measurement of character glyphs when you hover 

over the glyph; Overlay makes prototyping Photoshop mockups for 

Web design extremely simple, with grids that change your browser 

to a set breakpoint; and Loupe lets you sample and save colors to 

Adobe (ACO) files for use with Photoshop, Illustrator, etc.

If your design involves exact positioning of elements, or you 

want a tool to try out different designs across creative applica-

tions, then xScope 4 is indispensable. ■

teristics of the JPEGmini Pro version were identical to the original 

when viewed at 100%. When magnified at 200%, I could see tiny 

differences in small details.

An added benefit of the desktop edition is the interface, which 

has a gauge showing you the reduction rate or how much disk 

space you’ve saved. In addition, in the preferences you can also 

set an image size reduction to one of three presets, or a customiz-

able maximum width or height. Finally, you can choose to have 

the originals compressed or leave them alone. The Pro version also 

includes a plug-in for Adobe Lightroom. ■

 xScope 4

Company: Phase One Price:  $299; Upgrade: $99;  
Subscription: $10/month

Web: www.phaseone.com Rating: ◆ ◆ ◆ ◆ ◆

 Hot: Noise reduction; local adjustments; tethered shooting

 Not: 

Company: Beamr Price: $149

Web: www.jpegmini.com Rating: ◆ ◆ ◆ ◆

 Hot: No artifacts; excellent compression rates; fast

 Not: Only compresses JPEGs

www.xscopeapp.com
www.phaseone.com
www.jpegmini.com
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Powerful, Compact LED
 Review by Daniel M. East

Cloud-Based Photography Management
 Review by Michael Corsentino

An Umbrella, Octabox Combo Built for Speed
Review by Michael Corsentino

Thunderbolt 2 RAID Storage 
 Review by Daniel M. East

  Flashpoint CL-500R LED 
Circular Light 

 DF Studio

Creating the right lighting environment for our subjects where 

there’s no natural light can generate a lot of heat, as well as electri-

cal use from traditional fixtures. With the advent of LED (light emit-

ting diode) lighting, these two issues simply go away. As an excel-

lent addition to their CL-series LED panels, the Flashpoint CL-500R 

LED Circular Light takes it one step further with super-clean 5600K 

daylight color for some serious coverage that won’t break the bank. 

What sets the CL-500R apart, one might ask? It’s surprisingly 

small and it has a respectable, slightly tight, 60° coverage area. 

This makes it ideal for things like macro product photography, fill 

lighting, and some video applications. It includes a soft diffusion 

cover for portraits that works well on its own and with the addi-

tion of their larger CL-1300 model, for example. The CL-500R fits 

on most umbrella shaft sizes for easy mounting. Flashpoint offers 

some great accessories, such as an optional remote dimmer and 

battery pack.

The real aha! moment with this light wasn’t as much about 

the lack of heat or use of power, but the outstanding look of the 

As camera pixel counts grow, frame rates get faster, storage needs 

balloon, and photographic workflow becomes increasingly mobile 

in nature, the nagging question of how to implement the best 

asset management solution persists. Along with changing delivery 

methods, sizes, formats, and client expectations, our asset man-

agement needs and requirements are also growing and changing. 

Providing access to your images anywhere, anytime, the cloud-

based storage and photographic workflow service DF Studio 

offers an affordable, one-stop solution for online asset manage-

ment and delivery. Based around a robust, yet familiar set of tools, 

DF Studio gives you the power you need for a complete workflow 

without a steep learning curve. Using the rock-solid security and 

reliability of Amazon Cloud, DF Studio allows users to store, man-

age, edit, filter, review, share, request approval, and deliver files. 

Keep large libraries organized using DF Studio’s Active and Cold 

Storage, view file and folder sizes, select files across multiple proj-

ects, make collections without duplicating files, and create Web 

portfolios for image proofing and review. Users can send private 

approval messages to clients via DF Studio’s easy-to-use Messen-

ger feature, and deliver approved files directly from DF Studio. You 

can even watermark and scale your images, as needed.

Adorama recently introduced a line of useful and competitively 

priced light modifiers collectively known as Glow, part of their 

Flashpoint family of products. We’ll take a look the Flashpoint 

Glow HexaPop, a cross between a hexagonal octabox and an 

umbrella, designed specifically for on-the-go, external flash users. 

Available in both 20" and 24" models, the HexaPop is 

designed to work either on camera with a bracket and cable, 

or off with a light stand or stick. Owing to a unified, spring-

loaded design, the HexaPop can be set up or torn down in sec-

onds, requiring considerably less time and effort than traditional 

softboxes. The HexaPop’s spring-loaded, two-button release 

mechanism pops when engaged, hence the “pop” in HexaPop. 

This, along with internal support rods attached to the HexaPop’s 

fabric and built-in speedrings, enables it to be set up with the 

ease of an umbrella but have the superior quality and flexibility 

of an octabox. 

Made from high-quality, durable fabric and lined with silver to 

provide a more directional, efficient, and specular source, the Hexa-

Pop has one layer of diffusion fabric with no internal baffle. For this 

reason, you may want to feather this modifier to avoid hotspots.

If you’re unsure about adopting Thunderbolt technology for one 

reason or another, then wait no more. The need for speed is more 

important than ever to take advantage of your computer’s poten-

tial and, for storage, connectivity was often the weak link. Enter 

the ThunderBay 4 from Other World Computing (OWC). Now that 

Thunderbolt 2 is in place with most newer computers, there are 

more peripherals than ever that take advantage of the new blazing 

throughput speeds and add the kind of expansion that make things 

like backing up huge video and design files far less time consuming. 

Not only is this thing one of the fastest storage solutions on 

the market at this price, but it’s incredibly well thought out and 

includes features like email notifications with the use of SoftRAID 

for OS X. According to OWC, by combining the best of hard-

ware and software RAID features, they’re able to deliver better  

performance with less drain on other computing tasks. Plus, 

the Thunder Bay 4 has dual Thunderbolt 2 ports for even further 

expansion for things like monitors or hub expansion. With 32 MB 

of cache per drive (128 MB total), and depending on the drives 

you select, this thing is like a finely tuned F1 racecar. While the unit 

images with this smooth, white light. It’s not as warm in color as 

traditional lighting, but creating those color effects in Photoshop 

can be done after the fact. By adjusting the intensity, almost every 

subject will show its true colors and allow the exposures to be 

their best. The control stays in your hands with as much, or as 

little, light as you need. It includes a carrying case and all of the 

needed cables. ■

DF Studio provides a variety of upload and import options, sup-

porting virtually every known photographic file format, all with 

accurate previews and stacking algorithms for sidecar and RAW 

files. Plug-ins are available for Lightroom and PhotoMechanic, or 

use DF Studio’s own DFS Speed Link, a standalone desktop app 

to easily bulk upload images or create a watched folder for auto-

mated future uploads. 

There’s more to DF Studio than I can possibly cover here. Suffice 

it to say, DF Studio is a big winner and definitely worth a look. ■

Additionally, with some flashes, you may want to rotate their 

heads 90° when mounting them to the HexaPop bracket. This 

will position the body of the flash sideways, permitting the line-

of-sight, front-facing sensors to communicate properly with 

cameras and additional lights.

A carrying case and shoulder strap are included, making it 

easy to keep track of the HexaPop’s multiple pieces. ■

itself weighs in at around 9 lbs (without the drives installed), it’s 

quiet and smooth in its operation.

The ThunderBay 4 RAID storage isn’t just fast, it’s superior 

in performance to everything else in its class. It’s available as a 

housing (bring your own drives), and in capacities from 4–24 TB 

(the 12-TB unit was tested). Other World Computing continues to 

produce outstanding storage solutions for nearly every need and 

this latest addition is one of their finest to date. ■

 Glow HexaPop  ThunderBay 4 RAID 5 Edition

Company: Other World Computing Price: $1,088 as tested

Web: www.macsales.com Rating: ◆ ◆ ◆ ◆ ◆

 Hot: Speed; ease of use; expandable to 24 TB; quiet

 Not: 

Company: Adorama Camera, Inc. Price: $250

Web: www.adorama.com Rating: ◆ ◆ ◆ ◆ ◆

 Hot: Adjustable 5600k light; compact; ultra-low heat; accessories

 Not: 

Company: Adorama Camera, Inc. Price: $129.95–159.95

Web: www.adorama.com  Rating: ◆ ◆ ◆ ◆ ◆

 Hot: Lightweight; compact; durable fabric; rapid set up/tear down

 Not: No internal baffle; bracket assembly’s pieces easy to lose 

Company:  DigitalFusion Creative Price: Subscriptions from 
Technologies, Inc.   $20/month

Web: www.dfstudio.com Rating: ◆ ◆ ◆ ◆

 Hot: Secure; reliable; access anywhere; file handling

 Not: Lacking much support for video files

www.macsales.com
www.adorama.com
www.adorama.com
www.dfstudio.com
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R E V I E W S  ›  ›

Painting Software
 Review by Pete Collins

Single Camera System Accessories
 Review by Steve Baczewski

 ArtRage 4.5

ArtRage 4.5 is a painting program that’s worth checking out.  

It has so many natural-feeling brushes and options that you’ll love. 

The interface is clean and customizable so you can put everything 

you don’t need out of the way and just paint. It handles layers and 

blending like a champ and the ability to add shadowing to certain 

strokes is very nice. One of the neat features is that you can use 

reference images or other imagery for your paintings. I can’t believe 

the program is so cheap for what it offers, and there are versions 

for iPad and iPhone. 

There are a couple of little things that keep me from giving it a 

five-star rating. The brush preview and settings sometimes make it 

hard to see the subtle nuances that you may be trying to dial in to 

your brush. I wish it were bigger. Another item on my wish list is to 

be able to create my own brush tip shapes and add some random-

ness to the strokes so they don’t look so uniform. This can be seen 

with the oil paints that are thicker, especially in the corners where  

I wish the transitions were a bit smoother. 

The SpiderPro Single Camera System is a comprehensive camera 

carrying system that consists of a SpiderPro Camera Holster, Plate, 

Pin, and Belt. This system (sold separately, $135) serves as the 

basis for three accessories being reviewed: two lens pouches and 

a memory card organizer. [For a review of the SpiderPro Single 

Camera System, see Photoshop User, October 2012.—Ed.]

The base camera system has a funnel-shaped metal holster on 

the side of the belt that holds your camera. A metal plate with 

a projecting metal pin and a ballhead screws into your camera’s 

tripod mount, and then the metal ball slides into the holster’s slot. 

Your camera swivels upside down with lens facing back and rests 

securely on your hip. This arrangement allows for quick access that 

makes shooting much more spontaneous. A switch on the holster 

lets you lock the camera in the holster.

SpiderPro’s Memory Card Organizer and Medium and Large 

Lens Pouches loop onto the belt and help distribute the weight. 

The padded pouches are roomy and designed to accommodate 

your lens with lens hood attached, and include a water-resistant 

cover and a built-in tether to hold your rear lens cap. The memory 

Don’t let those things turn you off. You can tell the value of a 

product when it keeps surprising you with all the extra things it can 

do. I’m like a kid in a candy store trying to figure out which brushes 

and settings to use next. The limitations of this program are almost 

entirely due to my talent level and not any shortcoming of the prod-

uct. ArtRage 4.5 is highly recommended! ■

card organizer folds out and down from the belt and can hold 

three SD cards and six CF cards. 

I hiked 12 miles with my Canon EOS 5D Mark III and two lenses 

and the belt never slipped or rocked uncomfortably against my side. 

I swapped between my 70–200mm and 24–105mm Canon lenses 

with hoods attached with an ease I hadn’t experienced before. It’s 

the most comfortable, ergonomically efficient, and reassuringly 

safe solution for carrying your equipment for long hours in the field. 

Taking the weight off my shoulder and freeing my hands with easy 

access to my camera and lenses is a liberating experience. ■

  SpiderPro Memory Card Holder  
and Lens Pouches

Company: Ambient Design Ltd. Price: $49.90

Web: www.artrage.com Rating: ◆ ◆ ◆ ◆

 Hot: Realistic look and feel; loaded with options; value

 Not: Brush/tip preview; custom tips; randomness

Company: Shai Gear LLC Price:  Holder: $35; Medium Pouch: $65; 
Large Pouch: $75

Web: www.spiderholster.com Rating: ◆ ◆ ◆ ◆ ◆

 Hot: Hands-free; no strain; quick access

 Not: 

www.artrage.com
www.spiderholster.com
http://kelbyone.com
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B O O K  R E V I E W S  P E T E R  B A U E R  ›  ›

Black and white, including the few photos within, this book is 

all business (no pun intended). Much of the content consists of 

the author interviewing experts about specific aspects of the 

business of being a professional photographer. He also pro-

vides numerous sample forms and charts that you can use to 

stay organized and run your business. (If you’re the head of a 

studio and have an employee that handles most of the business 

side, provide that person with a copy of this book and ask how 

the book can contribute to the current workflow, and perhaps 

how he or she could improve the book.) While the book is a 

bit of a dry read, don’t dose off in the middle. You’ll find lots 

of little tips and simple tricks to improve your bottom line and 

protect your work from being used outside the terms of the 

contract for that job.

I almost walked past this book but thought it could be a gift for 

my wife. I soon realized that very little of the book is iPhone-

specific and is applicable to any smartphone or tablet camera. 

And then I saw that the final two-thirds of the book could be 

applied to most photography! The author also profiles nine 

photographers, interviewing them about photography and 

their careers and showing samples of their work. My favorite 

parts of the book are Chapter 3 and Chapter 4. “Spark Your 

Creativity” includes 100 photos with a short explanation of 

why each particular image represents a certain concept. The 

following chapter, “Shoot How You Feel,” includes 34 images, 

each with three descriptive words below. The author chal-

lenges you to choose which of the three words best describes 

the image. She also suggests that you come back at a later date 

and reevaluate your choices.  

The Art of iPhoneography: A Guide to Mobile CreativityMastering the Business of Photography: What the Pros 
Do When They’re Not Taking Incredible Pictures By Stephanie Calabrese Roberts
By Tony Luna

          

Publisher: Allworth Press Pages: 173

Website: www.allworth.com 

 Price:  $19.95  Rating:  ◆ ◆ ◆ ◆ ◆

Publisher: Pixiq/Sterling Publishing Pages: 160

Website: www.sterlingpublishing.com  

 Price: $19.95 Rating:  ◆ ◆ ◆ ◆ ◆

www.allworth.com
www.sterlingpublishing.com
http://kelbyone.com/marketplace/books/
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We all love tips because they are those little things that we didn’t 

know, or have forgotten. They’re the things that make you say 

“ahhh,” and smile. They save you time and make you look smart 

to other people. So, let’s hear it for tips!

No Background Layer, Just Beautiful Transparency
It’s common to convert a Background layer into a regular layer 

that can be edited. If you’re creating a new document, and 

you know that you need to start with an editable layer, why 

don’t you save yourself some time and create the document 

without a Background layer, but rather a transparent layer? This 

is essentially a blank layer with nothing in it that’s all ready for 

your content. You can do this in the New dialog (File>New) by 

choosing the Transparent option in the Background Contents 

drop-down menu.

Your Guide to Guides
Years ago, I remember trying to use chewing gum and string 

on my monitor to mark a position to align elements. Thankfully, 

Adobe added guides to Photoshop. To add guides to your docu-

ment, you need to first turn on Rulers (Command-R [PC: Ctrl-R]). 

You can click-and-drag from the horizontal and vertical rulers 

to create guides. These will sit wherever you drop them on your 

document. When you’re dragging out a guide, press the Option 

(PC: Alt) key to change the orientation of the guide from vertical 

to horizontal, or vice versa.

Refine Edge
When you’re cutting out objects with a selection tool, Refine 

Edge is useful for cleaning up the edges of a selection. It works 

similar to the options in the Select>Modify menu, but it’s visual 

and provides more options. Here’s a tip that will help you get 

nice clean edges. When you have an active selection, click the 

Refine Edge button in the Options Bar. In the Refine Edge dialog, 

click the Show Radius checkbox. Drag the Radius slider until you 

see an outline around the object. If the outline is thin, you’ll have 

a sharp selection; if it’s wider, then you’re able to create softer 

selections, which work well on hair and fur. 

Import PDF
Did you know that you can open a PDF into Photoshop? 

Choose File>Open and navigate to the PDF you’d like to open. 

In the Import PDF dialog, you have two options in the Select 

section. The Pages option allows you to open a select page 

or all pages and maintain the layout. The Images option gives 

you the ability to extract the images out of the PDF and use 

those. If you import multiple pages or images, they will open 

as separate documents. 

You can use this with the page layout tools in InDesign, such 

as text wrapping around images. You can also place extracted 

images into existing Photoshop documents by choosing File> 

Place Embedded or File>Place Linked, where they will load in as 

new layers. 

Batch Lens Correction
Do you have a number of images that you want to correct the 

distortion on? You’ll find this tip useful when shooting with a 

quadcopter or time-lapse sequences shot with a GoPro because 

these little cameras and lenses tend to create a fisheye distor-

tion effect. Photoshop has lens profiles that automatically cor-

rect these issues. You can load in images and correct them as 

you go, or you can choose File>Automate>Lens Correction and 

batch process a number of them all at once. In the Lens Correc-

tion dialog, click Browse and navigate to the folder or photos 

you’d like to correct. You can choose a Destination Folder, a Lens 

Correction Profile, and Correction Options. Click OK and watch 

Photoshop correct the distortion.

Brush Straight Lines
There are actually many different tools that are brushes. There’s 

the obvious Brush tool and there are others like the Dodge, Burn, 

Smudge, and Blur tools. They’re great freeform tools that enable 

you to have the creative freedom to paint and play as much and 

as randomly as you like. What happens when you want to con-

strain something, such as paint in a perfectly straight line? To 

constrain the Brush tool, click once, hold down the Shift key, 

and click again elsewhere in the document. A straight line will 

be drawn between the two points using the current brush shape 

and color.

Free up Resources in a Snap
Is your computer running slow? Maybe you’re working on a 

large image and have a smaller SSD, or you’re running out of 

space? Perhaps all your RAM is tied up and things are moving 

at a snail’s pace? There are a couple of things you can do to 

free up resources. The first thing to realize is your image size 

isn’t limited to the canvas size. It’s actually the size of the larg-

est layer, even though you can’t necessarily see all the pixels. 

To trim this down, press Command-A (PC: Ctrl-A) to select all, 

and choose Image>Crop. This alone can reduce the file size a 

lot. The second thing (sometimes the first thing) is to choose 

Edit>Purge and select one (or all) of the options in the menu. 

When you’re working in Photoshop, a number of things are 

loaded into memory, such as undo and history states. These 

can fill your memory and slow things down. In a pinch (say 

your RAM and scratch disk are so full that you can’t save your 

file), you can purge and free up enough resources to complete 

your critical task.

Sizing for HiDPI and Retina Displays
Retina and HiDPI displays can be a pain when used for creating 

Web assets. Sure, everything looks nice and smooth but (and a 

big but) the assets you’re creating for a website are displaying 

half the size they will when you export them. The solution is to 

go to View>200%. This will display the Web assets at the actual 

size that you’ll use them.

If you’re doing a lot of multimedia work and need a more 

permanent solution, locate the Photoshop application on your 

computer (it’s typically in your Applications folder). Click once on 

the app icon to highlight it, press Command-I, and turn on the 

Open in Low Resolution checkbox (PC: Right-click, select Proper-

ties, click on the Compatibility tab, and turn on Disable Display 

Scaling on High DPI Settings). Now images will display at normal 

size until you turn that option off. ■

Overlay View When Cropping
When you’re cropping a photo, you’re actu-

ally working with a powerful composition tool. 

The way you crop the photo will affect its com-

position and the way the viewer’s eye is guided 

around the image. There are some visual aids 

that can help you achieve the perfect crop 

every time. With the Crop tool (C) active, press 

the O key to cycle through different crop over-

lays. You’ll see familiar ones, such as the rule 

of thirds and grids, but you’ll also see some like 

the golden ratio that are useful visual aids in 

the way the eye perceives an image. 

D E PA R T M E N T  › › › › P H O T O S H O P  T I P S

Photoshop Tips
  boost your productivity and creativity COLIN SMITH
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*Advertiser offers discount to KelbyOne members. Visit http://kelbyone.com/discounts for more information.
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To: Ursula
From: KelbyOne Help Desk

JDI stands for “just do it!” These are small tasks for the 

Adobe Photoshop team that help improve our Photo-

shop experience. Sometimes a JDI is a slight change to 

the interface to make a feature more discoverable (easier 

for a user to find). Some JDIs are tweaks to the way a 

feature works.

Typically, JDIs are requests from Photoshop users and 

those non-Adobe folks who help test the product before 

updates are released (typically called beta testers). At 

Photoshop World 2013 in Las Vegas, Adobe set up an 

area for attendees to make their suggestions directly to 

the Adobe engineers who work on Photoshop. In some 

cases the program code needed to make the change was 

written on the spot, right in front of the attendee who 

made the suggestion—what some referred to as the 

Code-a-Thon.

Some of the “why-didn’t-we-always-have-this?” 

changes include being able to select any color for the 

background of a new document. (The Background 

Contents menu through Photoshop CS6 was limited 

to White, Background Color, and Transparent. Now 

you can select Other from the menu or click the color 

swatch to the right of the menu and open the Color 

Picker to choose any color for the background of a 

new document.)

The Curves adjustment also now supports negative 

numbers—something you’ll likely never use—and you 

can now add 10 Color Sampler points instead of four—

something you’ll love if you use the Color Sampler tool 

(nested under the Eyedropper tool [I]). And the Color 

Sampler tool’s Options Bar has changed the Clear but-

ton to Clear All to make sure that you know exactly what 

you’re doing when you click that button.
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Among the most noticeable changes to the inter-

face are the Color and Swatches panels. Swatches now 

shows the most recently used colors as swatches at the 

top of the panel, and the Color panel has been revital-

ized with a number of configurations, including an inter-

face that most resembles the Color Picker as the default.

A number of JDIs that you may never notice are 

improved performance with Mercury Graphics Engine 

(especially Smart Sharpen); layer names that can be 

as long as 255 characters; changes to the behavior of 

the Direct Selection tool (nested under the Path Selec-

tion tool [A]) when clicking within a shape (unselected 

anchor points are visible); and a new option in 

Preferences>Interface for a narrower Options Bar for 

smaller displays. (Working on a 13" display? Check it 

out.) Share on Behance includes a number of new lan-

guages, and there’s now a Don’t Show Again box for 

the Missing Fonts warning message.

One change that you might not have noticed but 

probably will never live without again is the capability 

to change a Background layer to a regular layer with a 

single click. Rather than double-clicking the layer name 

Background and renaming the layer, simply click the 

lock icon to the right of the Background layer name 

in the Layers panel to convert it to a regular layer that 

supports transparency and can be moved in the Layers 

panel hierarchy. (The layer name automatically changes 

from Background to Layer 0. If you already have a layer 

named Layer 0, the new layer name is changed to the 

next available numeric layer number.)

If you have a pet peeve or have noticed a problem, 

let the Photoshop team know through this link: http://

feedback.photoshop.com/photoshop_family. ■   

What does “JDI” mean and how does it impact my work in Photoshop?—Ursula
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